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日本語

バージョンアップ情報
V1.7で更新される主な機能
RECENT FILESステータス画面の追加
読み込みしたファイルの情報を直近から最大 15個まで適用順に
リスト表示するステータス画面を追加しました。
RECENT FILESステータス画面では、Userファイル /Allファイ
ル /Sceneファイル /Referenceファイル /Lensファイルで各 3
個までの計最大 15個まで適用順にリスト表示します。
ステータス画面には、読み込みしたファイルの日時、ファイルの
種類、メディアの種類、ファイル名が表示されます。

USERメニューへの FILEメニューカスタマイズ登録
FILEメニューのうち、以下の項目を USERメニューに登録する
ことができるようになりました。

FILE > User > User Load SxS• 
  > User Save SxS
  > User Load USB
  > User Save USB
  > File ID
  > Recall User Preset

FILE > All > All Load SxS• 
  > All Save SxS
  > All Load USB
  > All Save USB
  > All Preset

FILE > Scene > Scene Recall SxS• 
  > Scene Store SxS
  > Scene Recall USB
  > Scene Store USB

メニューロック時のアサイナブル設定無効化
メニューロック時、USERメニューに登録していない項目が
Assignable SWに割り当てられていた場合、設定が無効になり
ます。
USERメニュー以外のメニュー設定を変更したくないときに有効
です。
ご注意
下表のセットアップメニューのメニュー項目を USERメニューに
登録せずにメニューをロックした場合、同機能を Assignable 
SWに設定することはできません。

セットアップメニューのメ
ニュー項目

Assignable SWに割り当て
ることができるメニュー項目

OPERATION > Rec Function > 
Picture Cache Rec Picture Cache

OPERATION > Rec Function > 
Clip Continuous Rec Clip Continuous Rec

OPERATION > VF Setting > 
Mode EVF Mode

OPERATION > Display On/
Off > Brightness Display BRT Disp

OPERATION > Display On/
Off > Histogram Display Histogram

OPERATION > Display On/
Off > Lens Info Lens Info

OPERATION > TLCS > 
Mode

Spotlight

Backlight

OPERATION > TLCS > AGC*

EZ ModeOPERATION > TLCS > Auto 
Shutter*

OPERATION > Marker > 
Setting Marker

MAINTENANCE > Audio > 
Front MIC Select Front Mic

AGC、Auto Shutterのどちらか一方でも USERメニューに登* 
録していなければ、Assignable SWで EZ Modeを選択するこ
とはできません。

SxSメディア記録時間の改善
クリップを複数記録した場合の SxSメディアの最長記録時間を改
善しました。

V1.6で更新される主な機能
ビデオフォーマット
exFATモード時の IMX記録に対応しました。

exFAT/SDモード時の OPERATION > Format > Rec Format• 
メニュー設定値に、IMX50を追加しました。

USERメニューの追加
新たに USERメニューを設け、OPERATION、PAINT、
MAINTENANCEに入っているメニューの中から、ご使用になる
頻度の高い任意の項目を USERメニューに登録することができま
す。登録は USER MENU CUSTOMIZEメニューで行います。

メニューのロック機能の追加
セットアップメニューの表示にロックをかけて、USERメニュー
だけの表示にすることができる機能が追加になりました。

MENUつまみを押しながらMENU ON/OFFスイッチを押し下• 
げて、セットアップメニューを表示させ、User Menu with 
Lock>Onに設定して暗証番号を入力することで、メニュー表
示にロックをかけ、USERメニューだけの表示にできます。 
USERメニュー以外のメニュー設定を変更したくないときに有
効です。
ロックを解除するには、MENUつまみを押しながらMENU • 
ON/OFFスイッチを押し下げて、セットアップメニューを表示
させ、User Menu with Lock>Offに設定し、ロックをかけた
ときの暗証番号を入力することで、全メニューリスト表示に戻
ります。
ご注意
暗証番号は、忘れたときのため、手元に記録を残すことをお勧め
します。忘れたときはサービス窓口にお問い合わせください。

2スロット同時記録
2つの SxSスロットを使用した同時記録に対応しました。
OPERATION > Rec Function > Simul Recで機能の On/Offを
切り替えられます。



   

対応フォーマットは以下になります。
exFAT/HDモードの下記フォーマットのとき• 

XAVC-I –
XAVC-L50、L35、L25 –
MPEG2 HD422 –
MPEG2 HD420HQ –

UDF/HDモードの下記フォーマットのとき• 
MPEG2 HD422 –
MPEG2 HD420HQ –

ご注意
同時記録の際は、同じ種類、同じサイズのメモリーカードを使• 
用してください。
同時記録機能は、下記の機能と同時に使用することはできませ• 
ん。
フレームレック –
クリップコンティニュアスレック –
ピクチャーキャッシュレック –
スロー＆クイックモーション –
インターバルレック –
同時記録時は、USBワイヤレス LANモジュール IFU-WLM3は• 
使用できません。

SDXCカードに対応
別売りのメディアアダプターMEAD-SD02を使用して、SDXC
カードに記録・再生することができます。
SDXCカードは、exFATモード時のみ使用できます。
SDXCカード（SDスピードクラス：Class10）
ご注意
本機で SDXCカードを使用する場合は、本機のフォーマット機• 
能を使用してフォーマットしてから、ご使用ください。
SDXCカードを使って高速再生を行う場合、正しく動作しない• 
ことがあります。
SDXCカードと他のメモリーカードを同時に使用しないでくだ• 
さい。違う種類のメディアを使用した場合、記録中にメディア
がフルになっても自動切り換えができません。
ご使用になる SDXCカードによっては、XAVC-Iでの記録や、• 
スロー＆クイックモーション撮影が正常に記録できない場合が
あります。SxSメモリーカードのご使用を推奨します。
PMWシリーズおよび PXWシリーズのカムコーダーで記録し• 
た SDXCカードは、機種によって本機で記録・再生できない場
合があります。詳しくは、お買い上げ店またはソニーのサービ
ス窓口にご確認ください。

ダイレクトメニューの追加
ダイレクトメニューを有効にすると、MENU ON/OFFスイッチ
でメニューを表示させずに、ビューファインダー画面の表示項目
から設定を変更することができます。
ダイレクトメニューは、MAINTENANCE >Direct Menuを On
にすると有効になります。
ダイレクトメニュー設定を有効にし、MENUつまみを使って直
接操作します。操作できる項目は以下になります。
ホワイトバランスの COLOR TEMP設定• 
TLCSのモード設定• 
電子シャッターのシャッタースピードまたは蓄積フレーム数設• 
定
スロー＆クイックモーションのフレームレート設定• 
ご注意
ダイレクトメニューの対象項目でも、ビューファインダー画面• 
での表示が非表示（メニューの OPERATION >DisplayOn/Off

の設定が Off）になっている場合は、ダイレクトメニューで操
作することはできません。
項目によってダイレクトメニューを有効にするために以下の条• 
件があります。
ホワイトバランスの COLOR TEMP設定  –
WHITE BAL（ホワイトバランスメモリー切り換え）スイッチ
が Aまたは Bであること。また、WHITE BALスイッチが B
のときは、メニューの OPERATION>White Setting>White 
Switch<B>がMemoryであること。
電子シャッターのシャッタースピード設定  –
全モード共通： 
SHUTTERスイッチが ONであること。 
Speedモードの場合： 
メニューの OPERATION>Shutter>Shutter Selectが
Secondであること。 
Angleモードの場合： 
メニューのOPERATION>Shutter>Shutter SelectがDegree
であること。 
ECSモードの場合： 
ECSモードに設定されていること。
電子シャッターの蓄積フレーム数設定  –
Slow Shutterモードの場合は、メニューの
OPERATION>Shutter>Slow Shutterが Onであること。
スロー＆クイックモーションのフレームレート設定  –
メニューの OPERATION>Rec Function>Slow & Quickが
Onであること。

本機で記録したオリジナルファイルの部分転送
本機で記録したオリジナルファイルにイン点／アウト点を指定し
て、切り出した部分を転送することができます。 
また、ストーリーボードを使用すると、複数ファイルから切り出
した部分を転送することができます。
部分転送するには、以下の機器およびアプリケーションが必要に
なります。
本機にワイヤレスアダプター CBK-WA101（別売）を取り付ける。• 
本機とWireless LAN接続したデバイスで、Content Browser • 
Mobileアプリケーションを使用する。（Content Browser 
Mobileアプリケーションは、最新のバージョンをご使用くだ
さい。）
オリジナルファイルの対応フォーマットは以下になります。

exFAT/HDモードの下記フォーマットのファイル• 
XAVC-I –
XAVC-L50、L35、L25 –
MPEG2 HD422 –
MPEG2 HD420HQ –

UDF/HDモードの下記フォーマットのファイル• 
MPEG2 HD422 –
MPEG2 HD420HQ –

ご注意
オリジナルファイルの部分転送には、あらかじめオリジナルファ• 
イルと同一ファイル名のプロキシーファイルを以下の設定で記
録してください。

MAINTENANCE>Camera Config>SDI Rec Control>Para  –
Rec
MAINTENANCE>Camera Config>Match Clip Name>On –
オリジナルファイルの部分転送中は、以下の操作ができません。• 
クリップ操作 –
メディアのフォーマット –



   

コンピューターとの USB接続 –
オリジナルファイルの部分転送中は、ピクチャーキャッシュレッ• 
クのピクチャーキャッシュメモリーに画像を蓄積する時間が
OPERATION>Rec Function>P.Cache Rec Timeで設定した時
間より短くなります。

Wi-Fiリモコン設定のステータス表示の追加
アサイナブルスイッチ／リモートステータス画面に
MAINTENANCEメニューのWi-Fi Setting > Wi-Fi Remoteの設
定表示を追加しました。

Wi-Fiメニューについて
ワイヤレスアダプター CBK-WA101（別売）接続時に、
MAINTENANCEメニューのWi-Fi Setting > Wi-Fiと、Wi-Fi 
Setting > Wi-Fi Remoteが設定できるようになりました。

画面表示の追加
ワイヤレスアダプター CBK-WA101（別売）接続時、ビューファ
インダー画面に以下の状態を表示できるようになりました。
ワイヤレスアダプター CBK-WA101（別売）状態表示に、有線• 
LAN接続時の状態を表示します。
ネットワーククライアントモードの接続状態を表示します。• 
ストリーミング状態を表示します。• 

V1.5 で更新される主な機能
ビデオフォーマット
exFATモード時のMPEG2記録に対応しました。

exFATモード時の OPERATION > Format > HD/SDメニュー• 
で SDが選択できるようになりました。
exFAT/HD/720モード時の OPERATION > Format > System • 
Frequencyメニュー設定値に、29.97P、23.98P、25Pを追加
しました。
exFATモード時の OPERATION > Format >Rec Formatメ• 
ニュー設定値に、HD422、HQ、DVCAMを追加しました。

V1.4で更新される主な機能
ビデオフォーマット
XAVC Long GOP方式（XAVC-L）に対応しました。

exFATモード時の OPERATION > Format > Rec Formatメ• 
ニュー設定値に、XAVC-L 50、XAVC-L 35、XAVC-L 25を追加
しました。

CBK-CE01のバージョン表示に対応しました。
MAINTENANCE > Versionに、CBK-CE01を追加しました。• 

V1.3で更新される主な機能
ビデオフォーマット
XAVCイントラフレーム方式（XAVC-I）に対応しました。

OPERATION > Format > File System. メニュー設定値に、• 
exFATを追加しました。exFATを選択すると自動的に XAVC-I
に設定されます。

V1.22 で更新される主な機能
機能を改善しました。

HXCU-FB70と組み合わせたとき、HXCU-FB70の PRESET • 
（ホワイトバランスプリセット）ボタンが有効になりました。
MAINTENANCEメニュー > Genlock > Referenceに CAと表• 
示するようにしました。
Countryが PALに設定されているときに、白黒液晶表示部の状• 
態表示エリアに NDFが表示されないように改善しました。

UDFモードでRec FormatをHD420 HQ1920に選択したとき、• 
ビューファインダー画面のビデオフォーマット表示を改善しま
した。

V1.2 で更新される主な機能
USBメディア接続機能
OPTION端子に USBインターフェースを持つハードディスクや
フラッシュメモリーなどの外部ストレージメディアを接続し、コ
ピーや再生ができるようになりました。

MAINTENANCEメニューに USB Setを追加しました。このメ• 
ニューを使って USBメディア操作ができます。
SxSメモリーカードに収録されたクリップを外部ストレージメ• 
ディアにバックアップコピーできるようになりました。
外部ストレージメディア内のクリップを SxSメモリーカードに• 
コピーできるようになりました。
外部ストレージメディア内のクリップを再生できるようになり• 
ました。
ご注意
外部ストレージは、5.0V/0.5Aの電源で動作する機器に対応し• 
ています。それ以外のストレージは、本機で認識されない場合
があります。その際はストレージに電源を供給してください。
すべてのメディアの動作を保証するものではありません。動作• 
確認済みのメディアについてはお買い上げ店にお問い合わせく
ださい。
USBメディアをお使いになる場合は、本機のメニューの• 
Format USBでフォーマットを行ってからご使用ください。

カメラアダプター
カメラ―アダプターを装着したときのインサイドパネル側スイッ
チ操作に対応しました。

MAINTENANCEメニューの Camera Config > CCU • 
OPERATIONで、本体スイッチ操作の Normal/Local設定（無
効／有効）が可能です。
ご注意
本体スイッチ操作の設定を変更するときには、本体が自動的に• 
再起動されます。
本体スイッチ操作を有効にした場合、CCU側のリモコンへの表• 
示、CCU側からのリターンビデオの表示、CCU側からのタリー
やコールの表示は動作しますが、CCU側のリモコン操作や
REMOTE端子を介したリモート操作は無効となります。

収差補正
収差補正の性能を改善しました。

V1.1で更新される主な機能
フラッシュバンド補正
フラッシュバンド補正に対応しました。

OPERATION•  > Flashband Reduceメニューで、フラッシュバ
ンド補正機能の On/Off設定が可能です。
OPERATION•  > Assignable SWメニューで、 On/Off設定
(Flashband Reduce)をアサイナブルボタンに割り当てること
が可能です。
OPERATION•  > Display On/Off > Flashband Reduceメニュー
で、フラッシュバンド補正状態表示の On/Off設定が可能です。
ご注意
フラッシュバンド補正機能の On/Off設定切り替え時には、映• 
像や音声が乱れることがあります。
フラッシュバンド補正機能が On設定のときに、Shutter設定• 



   

を Onにすると、自動的に補正機能が Offになります。
ピクチャーキャッシュ記録モード、S&Q記録モード、スロー• 
シャッター、i.LINK出力時には、フラッシュバンド補正機能を
Onにすることができません。
本体の電源を入れ直すと、フラッシュバンド補正機能設定が• 
Offになりますので、再度設定を Onにしてください。

多言語メニュー、メッセージ ※ PMW-400のみ
スペイン語、ポルトガル語、ロシア語、インドネシア語のメニュー、
メッセージ、及び日本語のメッセージに対応しました。
MA > Language > Languageメニュー設定値に、Japanese、
Spanish、Portuguese、Russian、Indonesian を追加しました。
ご注意

Japaneseを選択した場合には、メニューは英語表示で、メッ• 
セージが日本語表示となります。

ワイヤレスアダプター
ワイヤレスアダプター CBK-WA101(別売 )との接続に対応しま
した。

MA > Camera Config > SDI Rec Controlメニューで同期記録• 
にするための Para Rec設定が可能です。
MA > Camera Config > Match Clip Nameメニューで同期記• 
録時のクリップ名合わせの On/Off設定が可能です。
OPERATION•  > Display On/Off > Wireless Statusメニューで
ワイヤレスアダプターの電波状態表示の On/Off設定が可能で
す。
OPERATION•  > Display On/Off > Ext Media Remainメニュー
でワイヤレスアダプターに装着されている SDカードの残記録
時間表示の On/Off設定が可能です。
OPERATION•  > Display On/Off > Sending Clip Infoメニュー
でワイヤレスアダプターを介したクリップ転送状態表示の On/
Off設定が可能です。
ご注意
ワイヤレスアダプターを接続しているときは、Wi-Fiアダプター • 
CBK-WA01や USB無線 LANモジュール IFU-WLM3を装着し
たWi-Fi機能は使用できません。
特殊記録の Para Recに設定できません。 Para Recに設定でき• 
るビデオフォーマットは以下の通りです。 
1920× 1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440× 1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280× 720/59.94P, 50P

USB無線 LANモジュール
USB無線 LANモジュール IFU-WLM3 (別売 )を装着したWi-Fi
接続が可能になりました。
ご注意

MA > Wi-Fi Setting > Scan Networksメニュー操作による• 
NETWORK SCANリストには SSIDと Chのみ表示されます。
接続先を選択したら、 MA > Wi-Fi Setting > Network Typeメ
ニューを設定し直してください。
Network Typeメニュー設定が Adhocの場合、 MA > Wi-Fi • 
Setting > Wi-Fi Status表示がグレーアウトされ、通信接続状
態が表示されません。

ビデオフォーマット
UDF (MXF) HD420 35Mbps 1920× 1080 記録フォーマットに
対応しました。

UDF/HD/1080モード時の• OPERATION > Format > Rec 
Formatメニュー設定値に、HD420 HQ1920を追加しました。

ALAC(収差補正機能 )
ALAC 機能をオフできるようになり、その状態も表示できるよう
になりました。

MA > Camera Config > ALAC メニューで、収差補正機能の• 
Auto/Off 設定が可能です。REMOTE 端子を介したリモート操
作も可能です。
OPERATION • > Display On/Off >ALAC メニューで、収差補正
機能状態表示の On/Off 設定が可能です。状態表示設定 On時
では、収差補正機能設定が Autoで対応レンズにて補正されて
いるときに、VF画面に ALAC と表示されます。
ご注意
対応レンズ接続時でも補正されないときには表示されません。• 
そのときには、レンズのキャリブレーション等を行なってくだ
さい。

English

Release Note
Major functions updated with V1.7
Adding the RECENT FILES Status Screen
The status screen displays file information (up to 15) that was 
recently loaded on the list in the loaded order. 
In the RECENT FILES status screen, you can display on the list up 
to 15 files of file information (up to 3 each for User file, All file, 
Scene file, Reference file, or Lens file).
The date and time which the file is loaded, file type, media type, 
and file name are displayed.

Registering the file customizing menu to the USER menu
The following items in the FILE menu can be registered to the 
USER menu.

FILE > User > User Load SxS•	
  > User Save SxS
  > User Load USB
  > User Save USB
  > File ID
  > Recall User Preset

FILE > All > All Load SxS•	
  > All Save SxS
  > All Load USB
  > All Save USB
  > All Preset

FILE > Scene > Scene Recall SxS•	
  > Scene Store SxS
  > Scene Recall USB
  > Scene Store USB

Disabled the assignable setting while the menu is locked
If a menu item that is not registered on the USER menu is 
assigned to “Assignable SW” while the menu is locked, the 
assignable setting is disabled.
This function is useful when you do not want to change a menu 
setting other than the USER menu.
Note

If the menu is locked while the menu items of the setup menu 
listed below are not registered to the USER menu, the function of 
the menu item cannot be assigned to “Assignable SW.”



   

Menu items of the setup 
menu

Menu items that can be 
assigned to “Assignable 
SW”

OPERATION > Rec Function > 
Picture Cache Rec Picture Cache

OPERATION > Rec Function > 
Clip Continuous Rec Clip Continuous Rec

OPERATION > VF Setting > 
Mode EVF Mode

OPERATION > Display On/
Off > Brightness Display BRT Disp

OPERATION > Display On/
Off > Histogram Display Histogram

OPERATION > Display On/
Off > Lens Info Lens Info

OPERATION > TLCS > Mode
Spotlight

Backlight

OPERATION > TLCS > AGC*

EZ ModeOPERATION > TLCS > Auto 
Shutter*

OPERATION > Marker > 
Setting Marker

MAINTENANCE > Audio > 
Front MIC Select Front Mic

Even if either “AGC” or “Auto Shutter” is not registered to the * 
USER menu, “EZ Mode” cannot be selected by “Assignable SW.”

Recording time of an SxS media is improved
The maximum recording time of an SxS media for recording 
multiple clips is improved.

Major functions updated with V1.6
Video format
IMX recording is supported in exFAT mode.

IMX50 is added to the menu setting item for OPERATION> •	
Format>Rec Format in exFAT/SD mode.

Adding the USER menu
USER menu is newly added and you can register frequently-used 
items under OPERATION, PAINT, or MAINTENANCE menus to the 
USER menu. Registration can be done at the USER MENU 
CUSTOMIZE menu.

Adding the locking menu function
Function to lock the Setup menu and to only display USER menu 
is added.

Keep pressing the MENU knob and press the MENU ON/OFF •	
switch down at the same time to display the Setup menu and 
enter the password at User Menu with Lock>On to lock the 
menu display and only display the USER menu. 
This function is useful when you do not want to change menu 
settings other than those in the USER menu.
To release the lock and display all the menu lists again, keep •	
pressing the MENU knob and press the MENU ON/OFF switch 

down at the same time to display the Setup menu, then enter 
the same password entered when you locked the menu.

Note

Keeping your password is recommended for future reference. If 
you forget your password, contact a Sony service representative.

Simultaneous Recording in 2 slots
Simultaneous recording using 2 SxS slots is supported.
Functions can be switched On/Off from OPERATION>Rec 
Function>Simul Rec.
The following formats are supported:

The following formats in exFAT/HD mode•	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

The following formats in UDF/HD mode•	
MPEG2 HD422–
MPEG2 HD420HQ–

Notes
When using Simultaneous Recording, use memory cards with •	
the same type and size.
Simultaneous Recording cannot be used with the following •	
functions simultaneously:

Frame Recording–
Clip Continuous Recording–
Picture Cache Recording–
Slow & Quick Motion–
Interval Recording–

The IFU-WLM3 USB Wireless LAN Module cannot be used •	
during simultaneous recording.

Supports the SDXC card
By using an optional MEAD-SD02 Media Adaptor, you can record 
and play an SDXC card.
SDXC card can only be used when in exFAT mode.
SDXC card (SD Speed Class: 10)
Notes

When you use the SDXC card with this unit, format it using the •	
unit’s formatting function.
High-speed playback may not be properly achieved with an •	
SDXC card.
When you use an SDXC card, do not use other types of memory •	
cards simultaneously. If you use other types of media 
simultaneously, switching to other media cannot be executed 
when the media has no space while recording.
Recording with XAVC-I format or the Slow & Quick Motion •	
recording may not be performed correctly depending on the 
SDXC card used. An SxS memory card is recommended.
An SDXC card recorded with the camcorder of the PMW and •	
PXW series may not be able to be used for recording and 
playback with this unit depending on the type of unit used. For 
details, contact your Sony dealer or a Sony service 
representative.

Adding the direct menu
When the direct menu is enabled, settings can be changed from 
display items in the viewfinder screen without displaying the 
menus with the MENU ON/OFF switch.
The direct menu is enabled when the MAINTENANCE 
menu>Direct Menu is set to On.
Enable the direct menu setting and operate it directly by using 
the MENU knob. The following items can be operated.

COLOR TEMP settings of the white balance•	
Mode settings for TLCS•	



   

Shutter speed of the electronic shutter or settings for the •	
number of accumulated frames
Frame rate setting in Slow & Quick Motion mode•	

Notes
When the items for the direct menu are not displayed in the •	
viewfinder screen (OPERATION menu>Display On/Off is set to 
Off ), you cannot operate those items with the direct menu.
These are the following conditions for enabling the direct menu •	
depending on the items.

COLOR TEMP setting of the white balance –
When the WHITE BAL (switching the white balance memory) 
switch is positioned at “A” or “B,” and when the WHITE BAL 
switch is positioned at “B” while OPERATION>White 
Setting>White Switch<B>>Memory in the menu
Shutter speed setting of the electronic shutter –
All modes: 
The SHUTTER switch is set to ON. 
Speed mode: 
OPERATION>Shutter>Shutter Select>Second in the menu 
Angle mode: 
OPERATION>Shutter>Shutter Select>Degree in the menu 
ECS mode: 
The ECS mode is set.
Accumulated frame number setting of the electronic shutter –
Slow Shutter mode: OPERATION>Shutter>Slow Shutter>On in 
the menu
Frame rate setting in Slow & Quick Motion mode –
OPERATION>Rec Function>Slow & Quick>On in the menu

Partial transfer of an original file recorded on this unit
You can transfer a cutout part of a file by specifying In and Out 
points in the original file recorded by this unit.  
You can also transfer the cutout parts of multiple files using the 
Storyboard.
The following device and application are required for partial 
transfers.

Attach the wireless adapter CBK-WA101 (optional) to this •	
camcorder.
Use the Content Browser Mobile application on the device •	
which is connected through Wireless LAN with this camcorder. 
(Use the latest version of the “Content Browser Mobile” 
application.)

The following the original files are supported:
The following files in exFAT/HD mode•	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

The following files in UDF/HD mode•	
MPEG2 HD422–
MPEG2 HD420HQ–

Notes
To transfer the original file partially using the “Content Browser •	
Mobile,” record the proxy file with the same file name as the 
original file with the following settings.

MAINTENANCE menu>Camera Config>SDI Rec Control>Para –
Rec
MAINTENANCE menu>Camera Config>Match Clip Name>On–

While transferring the original file partially, the following •	
operations cannot be done.

Clip operation–
Formatting media–
Connecting to the PC via USB–

While partially transferring the original file, the time to store •	
images in the picture cache memory of picture cache recording 

takes less time than the time set in the OPERATION menu>Rec 
Function>P. Cache Rec Time

Adding the status display of Wi-Fi remote control settings
The setting display of Wi-Fi Setting>Wi-Fi Remote under the 
MAINTENANCE menu is added to the assignable switches/
remote status screen.

Wi-Fi menu
When connecting through wireless adapter CBK-WA101 
(optional), you can set the Wi-Fi Setting>Wi-Fi and Wi-Fi 
Setting>Wi-Fi Remote under the MAINTENANCE menu.

Adding the screen display
The following status can be displayed on the viewfinder screen 
when the wireless adapter CBK-WA101 (optional) is connected.

Displays the status of the wired LAN connection to the wireless •	
adapter CBK-WA101 (optional) status display.
Displays the connecting status of network client mode.•	
Displays the streaming status.•	

Major functions updated with V1.5
Video Formats
PMW-400/580 is compatible with the format of MPEG2 recording 
in exFAT Mode.

SD can now be selected in “HD/SD” in “Format” of the •	
OPERATION menu in exFAT Mode.
“29.97P,” “23.98P,” and “25P” are added to the selectable items of •	
“System Frequency” in “Format” of the OPERATION menu in 
exFAT/HD/720 Mode.
“HD422,” “HQ,” and “DVCAM” are added to the selectable items of •	
“Rec Format” in “Format” of the OPERATION menu in exFAT 
Mode.

Major functions updated with V1.4
Video Formats
PMW-400/580 is compatible with the format of XAVC Long GOP 
(XAVC-L).

“XAVC-L 50,” “XAVC-L 35,” and “XAVC-L 25” are added for the •	
selectable items of “Rec Format” in “Format” of the OPERATION 
menu in exFAT Mode.

PMW-400/580 is compatible with the version display of CBK-
CE01.

“CBK-CE01” is added for “Version” of the MAINTENANCE menu.•	

Major functions updated with V1.3
Video Formats
PMW-400/580 is compatible with the format of XAVC intra-frame 
(XAVC-I).

“exFAT” is added for the selectable items of “File System” in •	
“Format” of the OPERATION menu. When “exFAT” is selected, 
“XAVC-I” is set automatically.

Major functions updated with V1.22
Functions are now improved.

When joined to the HXCU-FB70, the HXCU-FB70 PRESET (white •	
balance preset) button is enabled.
CA is now displayed in MAINTENANCE menu >Genlock> •	
Reference.
Improvements were made so that NDF does not appear in the •	
status display of the monochrome LCD Panel when Country is 
set to PAL.
Improvements were made to the video format display in the •	
viewfinder screen when HD420 HQ1920 has been set for Rec 
Format in UDF mode.



   

Major functions updated with V1.2
USB Media Connection Function
Copying and playback is supported for clips on external storage 
media with a USB interface, such as a hard disk or flash drive, by 
connection to the OPTION connector.

USB Set has been added to the MAINTENANCE menu. You can •	
operate a USB media by using this menu item.
Clips stored on SxS memory cards can now be copied to and •	
backed up on external storage media. 
Clips on external storage media can now be copied to SxS •	
memory cards. 
Clips on external storage media can now be played back •	
directly. 

Notes
External storage devices that operate from a 5.0 V/0.5 A power •	
source are supported. The unit may not recognize other storage 
devices. In such cases, supply a separate power source for the 
storage device. 
Operation is not guaranteed for all media. Consult the store •	
where you purchased the recorder about media verified for use 
in the unit.
Before using a USB media, format it by using Format USB on the •	
menu of the camcorder.

Camera adapter
Switch operations for the inside panel when the camera adapter 
is mounted are now supported.

The MAINTENANCE >Camera Config >CCU Operation menu •	
item allows you to set main unit switch operation to Normal or 
Local (i.e., disabled or enabled).

Notes
If you change the main unit switch operation setting, the unit •	
will restart automatically.
When main unit switch operation is enabled, display to the CCU •	
remote controller and display of return videos and tally and call 
operations from the CCU are enabled, but remote control via 
the CCU or via the REMOTE connector is disabled.

Aberration compensation function
The aberration compensation function is improved.

Major functions updated with V1.1
Flashband Reduce Function
PMW-400/580 is compatible with the flashband reduce function.

You can turn the flashband reduce function On/Off in •	
“Flashband Reduce” of the OPERATION menu.
The flashband reduce On/Off operation can be assigned to the •	
assignable button in “Assignable SW” of the OPERATION menu.
You can turn the flashband reduce status indication On/Off •	
from “Flashband Reduce” in “Display On/Off” of the OPERATION 
menu.

Notes
Video and audio may be distorted when the flashband reduce •	
function is set to “On” or “Off.”
When “Shutter” is set to “On” while the flashband reduce •	
function is set to “On,” the flashband reduce function is set to 
“Off” automatically.
The flashband reduce function cannot be set to “On” when the •	
camcorder is in picture cache mode, S&Q recording mode, slow 
shutter mode, or is outputting i.LINK.
The flashband reduce function is turned “Off” when the •	
camcorder is restarted. Set to “On” the function again.

Multi Language Menu and message (PMW-400 only)
Spanish, Portuguese, Russian and Indonesian menus and 
messages are available. Also, Japanese message is available.
“Japanese,” “Spanish,” “Portuguese,” “Russian,” and “Indonesian” are 
added in “Language” of the MAINTENANCE menu.
Note

The menus are displayed in English and messages are displayed •	
in Japanese when selecting “Japanese.”

Wireless Adapter
PMW-400/580 is compatible with the optional CBK-WA101 
Wireless Adapter.

You can set “SDI Rec Control” in “Camera Config” of the •	
MAINTENANCE menu to “Para Rec” to allow synchronized 
recording. 
You can turn the matching clip name function while •	
synchronized recording On/Off in “Match Clip Name” in “Camera 
Config” of the MAINTENANCE menu.
You can turn the wireless status indication for the wireless •	
adapter On/Off at “Wireless Status” in “Display On/Off” of the 
OPERATION menu.
You can turn the remaining time indication for an SD card •	
inserted into the wireless adapter On/Off at “Ext Media Remain” 
in “Display On/Off” of the OPERATION menu.
You can turn the clip uploading status indication via the •	
wireless adapter On/Off from “Sending Clip Info” in “Display On/
Off” of the OPERATION menu.

Notes
Wi-Fi functions of the CBK-WA01 Wi-Fi Adapter or IFU-WLM3 •	
USB wireless LAN module are not available when the wireless 
adapter is connected.
“Para Rec” cannot be set in special recording modes. You can •	
use the following video formats for “Para Rec.” 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

USB wireless LAN module
PMW-400/580 is compatible with the optional IFU-WLM3 USB 
wireless LAN module that allows Wi-Fi connection.
Notes

For the setting of “Scan Networks” in “Wi-Fi Setting” of the •	
MAINTENANCE menu, only “SSID” and “Ch” appear in the 
NETWORK SCAN list. Set “Network Type” in “Wi-Fi Setting” of the 
MAINTENANCE menu again after selecting the connection.
When “Network Type” is set to “Adhoc,” “Wi-Fi Status” in “Wi-Fi •	
Setting” of the MAINTENANCE menu is grayed out, and the 
connection status is not displayed.

Video Formats
PMW-400/580 is compatible with the recording format of UDF 
(MXF) HD420 35Mbps 1920×1080. 

“HD420 HQ1920” is added for the selectable items of “Rec •	
Format” in “Format” of the OPERATION menu in UDF/HD/1080 
Mode.

ALAC (Aberration Correction) Function
PMW-400/580 is compatible with the ALAC function and able to 
turn off the function. Also, the status is displayed accordingly. 

You can turn the ALAC function On/Off from “ALAC” in “Camera •	
Config” of the MAINTENANCE menu. The ALAC function can be 
operated remotely via the REMOTE connector.
You can turn the ALAC status indication On/Off from “ALAC” in •	
“Display On/Off” of the OPERATION menu. “ALAC” appears on 
the viewfinder screen when the ALAC status indication and 



   

ALAC function are set to “On” and “Auto” respectively and the 
aberration is corrected by ALAC compatible lens.

Note
“ALAC” is not displayed without aberration correction even •	
when an ALAC compatible lens is attached to the camcorder. In 
this case, calibrate the lens accordingly.

Français

Note de publication
Principales fonctions mises à jour dans la V1.7
Ajout de l’écran d’état RECENT FILES
L’écran d’état affiche les informations de fichier (jusqu’à 15) 
récemment chargées sur la liste dans leur ordre de chargement.
Sur l’écran d’état RECENT FILES, vous pouvez afficher dans la liste 
jusqu’à 15 fichiers d’informations de fichier (jusqu’à 3 chacun 
pour le fichier User, le fichier All, le fichier Scene, le fichier 
Reference ou le fichier Lens).
La date et l’heure de chargement du fichier, le type de fichier, le 
type de support et le nom de fichier s’affichent.

Enregistrement du menu de personnalisation de fichier 
dans le menu USER
Les éléments suivants du menu FILE peuvent être enregistrés 
dans le menu USER.

FILE > User > User Load SxS•	
  > User Save SxS
  > User Load USB
  > User Save USB
  > File ID
  > Recall User Preset

FILE > All > All Load SxS•	
  > All Save SxS
  > All Load USB
  > All Save USB
  > All Preset

FILE > Scene > Scene Recall SxS•	
  > Scene Store SxS
  > Scene Recall USB
  > Scene Store USB

Désactivation du réglage d’assignation lorsque le menu 
est verrouillé
Si un élément de menu non enregistré dans le menu USER est 
assigné à « Assignable SW » lorsque le menu est verrouillé, le 
réglage d’assignation est désactivé.
Cette fonction est utile lorsque vous ne souhaitez pas modifier un 
réglage de menu autre que le menu USER.
Remarque

Si le menu est verrouillé alors que les éléments de menu du 
menu de configuration répertoriés ci-dessous ne sont pas 
enregistrés dans le menu USER, la fonction de l’élément de menu 
ne peut pas être assignée à « Assignable SW ».

Éléments du menu de 
configuration

Éléments de menu 
pouvant être assignés à 
« Assignable SW »

OPERATION > Rec Function > 
Picture Cache Rec Picture Cache

OPERATION > Rec Function > 
Clip Continuous Rec Clip Continuous Rec

OPERATION > VF Setting > 
Mode EVF Mode

OPERATION > Display On/
Off > Brightness Display BRT Disp

OPERATION > Display On/
Off > Histogram Display Histogram

OPERATION > Display On/
Off > Lens Info Lens Info

OPERATION > TLCS > Mode
Spotlight

Backlight

OPERATION > TLCS > AGC*

EZ ModeOPERATION > TLCS > Auto 
Shutter*

OPERATION > Marker > 
Setting Marker

MAINTENANCE > Audio > 
Front MIC Select Front Mic

Même si « AGC » ou « Auto Shutter » n’est pas enregistré dans le * 
menu USER, « EZ Mode » ne peut pas être sélectionné par 
« Assignable SW ».

Durée d’enregistrement d’un support SxS améliorée
La durée d’enregistrement maximale d’un support SxS pour 
l’enregistrement de plusieurs clips est améliorée.

Principales fonctions mises à jour dans la V1.6
Format vidéo
L’enregistrement IMX est pris en charge en mode exFAT.

IMX50 a été ajouté comme option de paramètre de menu pour •	
OPERATION>Format>Rec Format en mode exFAT/SD.

Ajout du menu USER
Le menu USER est une nouveauté. Vous pouvez enregistrer vos 
options préférées des menus OPERATION, PAINT ou 
MAINTENANCE dans le menu USER. L’enregistrement est possible 
au moyen du menu USER MENU CUSTOMIZE.

Ajout de la fonction de verrouillage des menus
Une fonction a été ajoutée pour permettre de verrouiller le menu 
de configuration et d’afficher seulement le menu USER.

Appuyez simultanément sur le bouton MENU et sur le •	
commutateur MENU ON/OFF pour afficher le menu de 
configuration et saisir le mot de passe sous User Menu with 
Lock>On afin de verrouiller l’affichage des menus et d’afficher 
seulement le menu USER. 
Il s’agit d’une fonction utile quand vous ne souhaitez pas 
modifier les paramètres de menu, à l’exception de ceux du 
menu USER.
Pour déverrouiller et afficher à nouveau toutes les listes de •	
menu, appuyez simultanément sur le bouton MENU et sur le 
commutateur MENU ON/OFF pour afficher le menu de 
configuration, puis saisissez le mot de passe que vous avez saisi 
pour verrouiller le menu.



   

Remarque

Il est recommandé de noter votre mot de passe en vue de son 
utilisation ultérieure. Si vous oubliez votre mot de passe, 
contactez un représentant du service à la clientèle Sony.

Enregistrement simultané au moyen de 2 fentes
L’enregistrement simultané au moyen de 2 fentes SxS est pris en 
charge.
Les fonctions peuvent être activées/désactivées à partir de 
OPERATION>Rec Function>Simul Rec.
Les formats suivants sont pris en charge :

Les formats suivants en mode exFAT/HD•	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Les formats suivants en mode UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Remarques
En cas d’enregistrement simultané, utilisez des cartes mémoire •	
de même type et de même taille.
L’enregistrement simultané ne peut pas être utilisé en même •	
temps que les fonctions suivantes :

Enregistrement image par image–
Enregistrement en continu d’un plan–
Enregistrement dans le cache d’images–
Ralenti et accéléré–
Enregistrement à intervalles–

Le USB Wireless LAN Module IFU-WLM3 ne peut pas être utilisé •	
pendant l’enregistrement simultané.

Prise en charge de la carte SDXC
Avec l’adaptateur de support MEAD-SD02, en option, vous 
pouvez enregistrer et lire une carte SDXC.
Une carte SDXC ne peut être utilisée qu’en mode exFAT.
Carte SDXC (Classe de vitesse SD : 10)
Remarques

Quand vous employez la carte SDXC avec cet appareil, •	
formatez-la à l’aide de la fonction de formatage de l’appareil.
Une carte SDXC ne permet pas nécessairement la lecture •	
accélérée.
Quand vous employez une carte SDXC, n’utilisez simultanément •	
aucun autre type de carte mémoire. Quand il n’y a plus d’espace 
libre sur le support pendant l’enregistrement, il n’est pas 
possible de passer à un autre support si vous utilisez 
simultanément d’autres types de supports.
Il est possible que l’enregistrement au format XAVC-I ou •	
l’enregistrement en ralenti et accéléré ne se déroule pas 
correctement, selon la carte mémoire SDXC utilisée. Il est 
recommandé d’utiliser une carte mémoire SxS.
Selon le type d’appareil utilisé, il est possible qu’une carte SDXC •	
enregistrée avec un caméscope des gammes PMW et PXW ne 
convienne pas pour l’enregistrement et la lecture sur votre 
appareil. Pour plus de détails, contactez votre revendeur Sony 
ou un représentant du service à la clientèle Sony.

Ajout du menu direct
Quand le menu direct est activé, des paramètres peuvent être 
modifiés à partir des options d’affichage de l’écran du viseur sans 
afficher les menus à l’aide du commutateur MENU ON/OFF.
Le menu direct est activé quand le menu MAINTENANCE>Direct 
Menu est réglé sur On.

Activez le paramètre du menu direct et utilisez-le directement à 
l’aide du bouton MENU. Il est possible d’utiliser les options suivantes.

Paramètres COLOR TEMP de la balance des blancs•	
Paramètres de mode pour TLCS•	
Vitesse d’obturation de l’obturateur électronique ou paramètres •	
du nombres d’images accumulées
Réglage de la fréquence d’images en mode ralenti et accéléré•	

Remarques
Quand les options du menu direct ne sont pas affichées dans •	
l’écran du viseur (menu OPERATION>Display On/Off est réglé 
sur Off ), vous ne pouvez pas les utiliser avec le menu direct.
Voici les conditions requises pour permettre l’utilisation du •	
menu direct, selon les options.

Paramètre COLOR TEMP de la balance des blancs –
Quand le commutateur WHITE BAL (permutation de la 
mémoire de balance des blancs) est réglé sur « A » ou « B » et 
quand le commutateur WHITE BAL est réglé sur « B » alors que 
OPERATION>White Setting>White Switch<B>>Memory est 
sélectionné dans le menu
Réglage de la vitesse d’obturation de l’obturateur électronique –
Tous les modes : 
Le commutateur SHUTTER est réglé sur ON. 
Mode Vitesse : 
OPERATION>Shutter>Shutter Select>Second dans le menu 
Mode Angle : 
OPERATION>Shutter>Shutter Select>Degree dans le menu 
Mode ECS : 
Le mode ECS est activé.
Réglage du nombre d’images accumulées de l’obturateur –
électronique 
Mode Slow Shutter : OPERATION>Shutter>Slow Shutter>On 
dans le menu
Réglage de la fréquence d’images en mode ralenti et accéléré –
OPERATION>Rec Function>Slow & Quick>On dans le menu

Transfert partiel d’un fichier d’origine enregistré sur cet 
appareil
Vous pouvez transférer une partie coupée d’un fichier en 
spécifiant les repères de début et de fin dans le fichier d’origine 
enregistré par cet appareil. 
Vous pouvez aussi transférer des parties coupées de plusieurs 
fichiers dans la Table de montage séquentiel.
Les transferts partiels nécessitent le périphérique et le logiciel 
suivants.

Connectez l’adaptateur sans fil CBK-WA101 (en option) à ce •	
caméscope.
Utilisez l’application Content Browser Mobile sur le périphérique •	
connecté à ce caméscope par l’intermédiaire du Wireless LAN. 
(Utilisez la dernière version de l’application « Content Browser 
Mobile ».)

Les fichiers originaux suivants sont pris en charge :
Les fichiers suivants en mode exFAT/HD•	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Les fichiers suivants en mode UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Remarques
Pour transférer partiellement le fichier original à l’aide de •	
l’application « Content Browser Mobile », enregistrez le fichier 
proxy portant le même nom de fichier que le fichier original 
avec les paramètres suivants.



   

Menu MAINTENANCE>Camera Config>SDI Rec Control>Para –
Rec
Menu MAINTENANCE>Camera Config>Match Clip Name>On–

Il n’est pas possible d’exécuter les opérations suivantes pendant •	
le transfert partiel du fichier original.

Manipulation des plans–
Formatage du support–
Connexion au PC via USB–

Pendant le transfert partiel du fichier original, le temps •	
nécessaire au stockage des images dans la mémoire cache 
d’images de l’enregistrement en cache des images est inférieur 
à la durée définie dans le menu OPERATION>Rec Function>P. 
Cache Rec Time

Ajout de l’affichage d’état aux paramètres de 
télécommande Wi-Fi
L’affichage des paramètres de Wi-Fi Setting>Wi-Fi Remote sous le 
menu MAINTENANCE est ajouté à l’écran d’état des 
commutateurs personnalisables/télécommande.

Menu Wi-Fi
En cas de connexion par l’intermédiaire de l’adaptateur sans fil 
CBK-WA101 (en option), vous pouvez définir Wi-Fi Setting>Wi-Fi 
et Wi-Fi Setting>Wi-Fi Remote sous le menu MAINTENANCE.

Ajout de l’affichage d’écran
L’état suivant peut être affiché sur l’écran du viseur quand 
l’adaptateur sans fil CBK-WA101 (en option) est connecté.

Affiche l’état de la connexion LAN filaire à l’affichage d’état de •	
l’adaptateur sans fil CBK-WA101 (en option).
Affiche l’état de connexion du mode client réseau.•	
Affiche l’état du streaming.•	

Principales fonctions mises à jour dans la V1.5
Formats vidéo
Le PMW-400/580 est compatible avec le format de 
l’enregistrement MPEG2 en mode exFAT.

SD est désormais disponible sous « HD/SD » dans « Format » du •	
menu OPERATION en mode exFAT.
« 29.97P », « 23.98P » et « 25P » sont ajoutés aux options •	
disponibles de « System Frequency » sous « Format » du menu 
OPERATION en mode exFAT/HD/720.
« HD422 », « HQ » et « DVCAM » sont ajoutés aux options •	
disponibles de « Rec Format » sous « Format » du menu 
OPERATION en mode exFAT.

Principales fonctions mises à jour dans la V1.4
Formats vidéo
Le PMW-400/580 est compatible avec le format de XAVC Long 
GOP (XAVC-L).

« XAVC-L 50 », « XAVC-L 35 » et « XAVC-L 25 » sont ajoutés aux •	
éléments disponibles de « Rec Format » sous « Format » du 
menu OPERATION en mode exFAT.

Le PMW-400/580 est compatible avec l’affichage de la version du 
CBK-CE01.

« CBK-CE01 » est ajouté à « Version » dans le menu •	
MAINTENANCE.

Principales fonctions mises a jour dans la V1.3
Formats vidéo
Le PMW-400/580 est compatible avec le format d’intra-image 
XAVC (XAVC-I).

« exFAT » est ajouté aux éléments disponibles de « File System » •	
sous « Format » du menu OPERATION. Lorsque « exFAT » est 
sélectionné, « XAVC-I » est réglé automatiquement.

Principales fonctions mises a jour dans la V1.22
Des fonctions ont été améliorées.

En cas de raccordement au HXCU-FB70, la touche PRESET •	
(préréglage de la balance des blancs) du HXCU-FB70 est activée.
CA est maintenant affiché dans le menu MAINTENANCE -> •	
Genlock>Reference.
Des améliorations ont été apportées afin que NDF n'apparaisse •	
pas dans l'affichage d'état du panneau LCD monochrome 
lorsque Country est réglé sur PAL.
Des améliorations ont été apportées à l’affichage du format •	
vidéo dans l’écran du viseur quand HD420 HQ1920 est 
sélectionné comme Rec Format en mode UDF.

Principales fonctions mises a jour dans la V1.2
Fonction de connexion de support USB
La copie et la lecture sont pris en charge pour les plans sur un 
support de stockage externe avec une interface USB, tel qu’un 
disque dur ou un lecteur flash en se connectant au connecteur 
OPTION. 

USB Set a été ajouté au menu MAINTENANCE. Vous pouvez •	
commander un support USB à l’aide de cette option de menu.
Les plans enregistrés sur les cartes mémoire SxS peuvent •	
maintenant être copiés et sauvergardés sur un support de 
stockage externe. 
Les plans sur un support de stockage externe peuvent •	
maintenant être copiés sur les cartes mémoire SxS. 
Les plans sur un support de stockage externe peuvent •	
maintenant être lus directement. 

Remarques
Les périphériques de stockage externe fonctionnant à partir •	
d’une source d’alimentation de 5,0 V/0,5 A sont pris en charge. 
L’appareil peut ne pas reconnaître d’autres périphériques de 
stockage. Dans ce cas, vous devez fournir une autre source 
d’alimentation pour le périphérique de stockage. 
Le fonctionnement n’est pas garanti avec tous les supports. •	
Vérifiez avec le magasin d’achat de l’enregistreur concernant les 
supports fonctionnant avec cet appareil. 
Avant d’utiliser un support USB, formatez-le au moyen de •	
l’option Format USB du menu du caméscope.

Adaptateur de caméra
Les opérations de basculement pour le panneau interne lorsque 
l’adaptateur de caméra est monté sont désormais prises en 
charge.

L’élément de menu MAINTENANCE >Camera Config >CCU •	
Operation vous permet de régler les opérations de basculement 
de l’unité principale sur Normal ou Local (par ex. désactivé ou 
activé).

Remarques
Si vous changez le réglage de l’opération de basculement de •	
l’unité principale, l’unité redémarrera automatiquement.
Lorsque l’opération de basculement de l’unité principale est •	
activée, l’affichage sur la télécommande CCU et l’affichage du 
retour vidéo et les opérations de signalisation et d’appel depuis 
la CCU sont activées alors que la télécommande par le biais de 
la CCU ou connecteur REMOTE est désactivée.

Fonction de correction de l’aberration
La fonction de correction de l’aberration a été améliorée.

Principales fonctions mises à jour dans la V1.1
Fonction de réduction Flash Band
Le PMW-400/580 est compatible avec la fonction de réduction 
Flash Band.



   

Vous pouvez activer/désactiver la fonction de réduction Flash •	
Band sous « Flashband Reduce » du menu OPERATION.
L’opération d’activation/de désactivation de la réduction Flash •	
Band peut être attribuée à la touche assignable sous 
« Assignable SW » du menu OPERATION.
Vous pouvez activer/désactiver l’indication d’état de réduction •	
Flash Band dans « Flashband Reduce » sous « Display On/Off » 
du menu OPERATION.

Remarques
La vidéo et l’audio peuvent être déformés lorsque la fonction de •	
réduction Flash Band est réglée sur « On » ou « Off ».
Lorsque « Shutter » est réglé sur « On » alors que la fonction de •	
réduction Flash Band est réglée sur « On », la fonction de 
réduction Flash Band se règle automatiquement sur « Off ».
La fonction de réduction Flash Band ne peut pas être réglée sur •	
« On » lorsque le caméscope est en mode de cache d’image, en 
mode d’enregistrement ralenti et accéléré, en mode 
d’obturation lente, ou en cas de sortie d’i.LINK.
La fonction de réduction Flash Band bascule sur « Off » lorsque •	
le caméscope redémarre. Basculez à nouveau la fonction sur 
« On ».

Menus et messages multilingues (PMW-400 uniquement)
Les menus et les messages sont disponibles en espagnol, en 
portugais, en russe et en indonésien. Les messages sont 
également disponibles en japonais
« Japanese », « Spanish », « Portuguese », « Russian » et 
« Indonesian » sont ajoutés à « Language » du menu 
MAINTENANCE.
Remarque

Si vous sélectionnez « Japanese », les menus s’affichent en •	
anglais et les messages en japonais.

Adaptateur sans fil
Le PMW-400/580 est compatible avec l’adaptateur sans fil CBK-
WA101 en option.

Vous pouvez régler « SDI Rec Control » sous « Camera Config » •	
du menu MAINTENANCE sur « Para Rec » afin d’autoriser 
l’enregistrement synchronisé.
Vous pouvez activer la fonction de nom de plan correspondant •	
tout en activant/désactivant l’enregistrement synchronisé dans 
« Match Clip Name » sous « Camera Config » du menu 
MAINTENANCE.
Vous pouvez activer/désactiver l’indication d’état sans fil de •	
l’adaptateur sans fil dans « Wireless Status » sous « Display On/
Off » du menu OPERATION.
Vous pouvez activer/désactiver l’indication de temps restant •	
pour une carte SD insérée dans l’adaptateur sans fil dans « Ext 
Media Remain » sous « Display On/Off » du menu OPERATION. 
Vous pouvez activer/désactiver l’indication d’état d’envoi du •	
plan via l’adaptateur sans fil dans « Sending Clip Info » sous 
« Display On/Off » du menu OPERATION.

Remarques
Les fonctions Wi-Fi de l’adaptateur Wi-Fi CBK-WA01 ou du •	
module LAN sans fil USB IFU-WLM3 sont indisponibles lorsque 
l’adaptateur sans fil est connecté.
« •	 Para Rec » est indisponible dans les modes d’enregistrement 
spéciaux. Vous pouvez utiliser les formats vidéo suivants pour 
« Para Rec ». 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

Module LAN sans fil USB
Le PMW-400/580 est compatible avec le module optionnel LAN 
sans fil USB IFU-WLM3 qui permet l’établissement d’une 
connexion Wi-Fi.
Remarques

Pour le réglage de « Scan Networks » sous « Wi-Fi Setting » du •	
menu MAINTENANCE, seuls « SSID » et « Ch » apparaissent dans 
la liste NETWORK SCAN. Sélectionnez à nouveau « Network 
Type » sous « Wi-Fi Setting » du menu MAINTENANCE après 
avoir la choisi la connexion.
Une fois « Network Type » réglé sur « Adhoc », « Wi-Fi Status » •	
sous « Wi-Fi Setting » du menu MAINTENANCE est grisé et l’état 
de connexion ne s’affiche pas.

Formats vidéo
Le PMW-400/580 est compatible avec le format d’enregistrement 
UDF (MXF) HD420 35 Mbps 1920×1080.

« HD420 HQ1920 » est ajouté aux éléments sélectionnables de •	
« Rec Format » sous « Format » du menu OPERATION en mode 
UDF/HD/1080.

Fonction ALAC (correction de l’aberration)
Le PMW-400/580 est compatible avec la fonction ALAC et peut 
désactiver cette fonction. De même, l’état s’affiche en 
conséquence.

Vous pouvez activer/désactiver la fonction ALAC dans « ALAC » •	
sous « Camera Config » du menu MAINTENANCE. La fonction 
ALAC peut être commandée à distance via le connecteur 
REMOTE.
Vous pouvez activer/désactiver l’indication d’état ALAC dans •	
« ALAC » sous « Display On/Off » du menu OPERATION. « ALAC » 
apparaît sur l’écran du viseur lorsque l’indication d’état ALAC et 
la fonction ALAC sont respectivement réglées sur « On » et 
« Auto » et que l’aberration est corrigée par un objectif 
compatible avec ALAC.

Remarque
« ALAC » ne s’affiche pas sans la correction de l’aberration, •	
même lorsqu’un objectif compatible avec ALAC est fixé au 
caméscope. Dans ce cas, calibrez l’objectif en conséquence.

Deutsch

Freigabemitteilung
Wichtige in V1.7 aktualisierte Funktionen
Statusbildschirm RECENT FILES neu hinzugekommen
Der Statusbildschirm zeigt Informationen zu Dateien (bis zu 15), 
die zuletzt geladen wurden, in der Liste an, und zwar in der 
Reihenfolge des Ladens.
Auf dem Statusbildschirm RECENT FILES können Sie in der Liste 
bis zu 15 Dateien mit Dateiinformationen anzeigen (bis zu je 3 
Dateien für User, All, Scene, Reference und Lens).
Datum und Uhrzeit des Ladens der Datei, Dateityp, Medientyp 
und Dateiname werden angezeigt.

Registrieren des Dateiverwaltungsmenüs im Menü USER
Die folgenden Optionen des Menüs FILE können im Menü USER 
registriert werden.

FILE > User > User Load SxS•	
  > User Save SxS
  > User Load USB
  > User Save USB
  > File ID
  > Recall User Preset



   

FILE > All > All Load SxS•	
  > All Save SxS
  > All Load USB
  > All Save USB
  > All Preset

FILE > Scene > Scene Recall SxS•	
  > Scene Store SxS
  > Scene Recall USB
  > Scene Store USB

Einstellung einer zugewiesenen Funktion ist deaktiviert, 
solange das Menü gesperrt ist
Wenn eine Menüoption, die nicht im Menü USER registriert ist, 
„Assignable SW“ zugewiesen ist und das Menü gesperrt wird, 
wird die Einstellung der zugewiesenen Funktion deaktiviert.
Diese Funktion ist nützlich, wenn nur noch die 
Menüeinstellungen im Menü USER zu ändern sein sollen.
Hinweis

Wenn das Menü gesperrt ist und die Menüoptionen des unten 
aufgelisteten Einstellungsmenüs nicht im Menü USER registriert 
sind, kann die Funktion der Menüoption nicht „Assignable SW“ 
zugewiesen werden.

Menüoptionen des 
Einstellungsmenüs

„Assignable SW“ 
zuweisbare Menüoptionen

OPERATION > Rec Function > 
Picture Cache Rec Picture Cache

OPERATION > Rec Function > 
Clip Continuous Rec Clip Continuous Rec

OPERATION > VF Setting > 
Mode EVF Mode

OPERATION > Display On/
Off > Brightness Display BRT Disp

OPERATION > Display On/
Off > Histogram Display Histogram

OPERATION > Display On/
Off > Lens Info Lens Info

OPERATION > TLCS > Mode
Spotlight

Backlight

OPERATION > TLCS > AGC*

EZ ModeOPERATION > TLCS > Auto 
Shutter*

OPERATION > Marker > 
Setting Marker

MAINTENANCE > Audio > 
Front MIC Select Front Mic

Selbst wenn „AGC“ oder „Auto Shutter“ nicht im Menü USER * 
registriert ist, kann „EZ Mode“ mit „Assignable SW“ nicht 
ausgewählt werden.

Längere Aufnahmedauer bei SxS-Medien
Die maximale Aufnahmedauer bei SxS-Medien für die 
Aufzeichnung mehrerer Clips ist länger.

Wichtige in V1.6 aktualisierte Funktionen
Videoformat
IMX-Aufzeichnung wird im exFAT-Modus unterstützt.

IMX50 wurde im exFAT/SD-Modus als Menüoption zu •	
OPERATION>Format>Rec Format hinzugefügt.

Neues Menü USER
Das Menü USER wurde neu hinzugefügt und Sie können häufig 
verwendete Optionen der Menüs OPERATION, PAINT und 
MAINTENANCE im Menü USER registrieren. Die Registrierung 
können Sie über das Menü USER MENU CUSTOMIZE vornehmen.

Neue Funktion zum Sperren der Menüs
Es gibt jetzt eine Funktion, mit der Sie das Einstellungsmenü 
sperren können, sodass nur das Menü USER angezeigt wird.

Halten Sie den Regler MENU gedrückt und drücken Sie •	
gleichzeitig den Schalter MENU ON/OFF nach unten, damit das 
Einstellungsmenü angezeigt wird, und geben Sie für User Menu 
with Lock>On ein Passwort ein, um die Menüanzeige zu 
sperren, sodass nur das Menü USER angezeigt wird. 
Diese Funktion ist nützlich, wenn nur noch die 
Menüeinstellungen im Menü USER zu ändern sein sollen.
Wenn Sie die Sperre aufheben möchten, sodass alle Menülisten •	
wieder angezeigt werden, halten Sie den Regler MENU gedrückt 
und drücken Sie gleichzeitig den Schalter MENU ON/OFF nach 
unten, damit das Einstellungsmenü angezeigt wird, und geben 
Sie dasselbe Passwort wie beim Sperren des Menüs ein.

Hinweis

Es empfiehlt sich, das Passwort zur späteren Verwendung zu 
notieren. Wenn Sie das Passwort vergessen, wenden Sie sich an 
einen Sony-Kundendienstmitarbeiter.

Simultanaufzeichnung in den 2 Einschüben
Die Simultanaufzeichnung in den 2 SxS-Einschüben wird 
unterstützt.
Die Funktion kann über OPERATION>Rec Function>Simul Rec 
aktiviert bzw. deaktiviert werden.
Die folgenden Formate werden unterstützt:

Die folgenden Formate im exFAT/HD-Modus•	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Die folgenden Formate im UDF/HD-Modus•	
MPEG2 HD422–
MPEG2 HD420HQ–

Hinweise
Verwenden Sie für die Simultanaufzeichnung Speicherkarten •	
desselben Typs und derselben Größe.
Die Simultanaufzeichnung kann nicht gleichzeitig zusammen •	
mit den folgenden Funktionen verwendet werden:

Einzelbildaufzeichnung–
Kontinuierliche Clipaufzeichnungen–
Aufzeichnung mit Bildpufferfunktion–
Zeitlupen- und Zeitrafferaufnahme–
Intervallaufzeichnung–

Das USB Wireless LAN Module IFU-WLM3 kann nicht während •	
der gleichzeitigen Aufzeichnung verwendet werden.

Unterstützung von SDXC-Karten
Mithilfe des optionalen Medienadapters MEAD-SD02 können Sie 
für die Aufnahme und Wiedergabe SDXC-Karten verwenden.
SDXC-Karten können nur im exFAT-Modus verwendet werden.
SDXC-Karte (SD-Geschwindigkeitsklasse: 10)



   

Hinweise
Wenn Sie eine SDXC-Karte mit diesem Gerät verwenden, •	
formatieren Sie sie mit der Formatierungsfunktion des Geräts.
Mit einer SDXC-Karte ist eine einwandfreie •	
Hochgeschwindigkeitswiedergabe eventuell nicht möglich.
Verwenden Sie zusammen mit einer SDXC-Karte nicht •	
gleichzeitig andere Speicherkartentypen. Wenn Sie gleichzeitig 
andere Medientypen verwenden und beim Aufzeichnen auf der 
Karte kein Platz mehr frei ist, können Sie nicht zu einem anderen 
Medium umschalten.
Die Aufzeichnung im XAVC-I-Format oder mit Zeitlupe und •	
Zeitraffer wird je nach verwendeter SDXC-Karte unter 
Umständen nicht korrekt ausgeführt. Es empfiehlt sich, eine 
SxS-Speicherkarte zu verwenden.
Je nach dem verwendeten Gerätetyp kann eine SDXC-Karte, auf •	
die mit einem anderen Camcorder der PMW- und PXW-Serie 
aufgezeichnet wurde, nicht für die Aufnahme und Wiedergabe 
mit diesem Gerät verwendet werden. Einzelheiten dazu 
erhalten Sie bei Ihrem Sony-Händler oder einem Sony-
Kundendienstmitarbeiter.

Neues Direktmenü
Wenn das Direktmenü aktiviert ist, können Sie über die Anzeigen 
im Sucherbildschirm Einstellungen ändern, ohne die Menüs mit 
dem Schalter MENU ON/OFF aufzurufen.
Das Direktmenü wird aktiviert, wenn Menü 
MAINTENANCE>Direct Menu auf On gesetzt wird.
Aktivieren Sie das Direktmenü und bedienen Sie es direkt mit 
dem Regler MENU. Die folgenden Optionen können eingestellt 
werden.

COLOR TEMP-Einstellungen für den Weißabgleich•	
Moduseinstellungen für TLCS•	
Belichtungszeit des elektronischen Verschlusses bzw. •	
Einstellungen für die Anzahl der akkumulierten Vollbilder
Bildrateneinstellung im Zeitlupen- und Zeitraffermodus•	

Hinweise
Wenn die Optionen des Direktmenüs nicht im Sucherbildschirm •	
angezeigt werden (Menü OPERATION>Display On/Off ist auf Off 
gesetzt), können diese Optionen mit dem Direktmenü nicht 
eingestellt werden.
Bei folgenden Bedingungen wird je nach Optionen das •	
Direktmenü aktiviert.

COLOR TEMP-Einstellungen für den Weißabgleich –
Wenn der Schalter WHITE BAL (Wechseln des 
Weißabgleichspeichers) auf „A“ oder „B“ steht und wenn der 
Schalter WHITE BAL auf „B“ steht, während OPERATION>White 
Setting>White Switch<B>>Memory im Menü eingestellt ist
Belichtungszeit des elektronischen Verschlusses –
Alle Modi: 
Der Schalter SHUTTER ist auf ON eingestellt. 
Geschwindigkeitsmodus: 
OPERATION>Shutter>Shutter Select>Second im Menü 
Winkelmodus: 
OPERATION>Shutter>Shutter Select>Degree im Menü 
ECS-Modus: 
Der ECS-Modus ist eingestellt.
Einstellung der Anzahl akkumulierter Vollbilder für den –
elektronischen Verschluss 
Slow Shutter-Modus: OPERATION>Shutter>Slow Shutter>On 
im Menü
Bildrateneinstellung im Zeitlupen- und Zeitraffermodus –
OPERATION>Rec Function>Slow & Quick>On im Menü

Teilweise Übertragung einer auf dieser Einheit 
aufgezeichneten Originaldatei
Sie können einen beschnittenen Teil einer Datei übertragen, 
indem Sie in der von dieser Einheit aufgezeichneten Originaldatei 
einen In- und einen Out-Punkt angeben. 
Sie können auch die beschnittenen Teile mehrerer Dateien unter 
Verwendung des Storyboards übertragen.
Für das Übertragen von Ausschnitten sind folgendes Gerät und 
folgende Anwendung erforderlich.

Bringen Sie den WLAN-Adapter CBK-WA101 (optional) an •	
diesem Camcorder an.
Verwenden Sie die Anwendung Content Browser Mobile auf •	
dem Gerät, das über Wireless LAN mit diesem Camcorder 
verbunden ist. (Verwenden Sie die neueste Version der 
Anwendung „Content Browser Mobile“.)

Folgende Originaldateien werden unterstützt:
Die folgenden Dateien im exFAT/HD-Modus•	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Die folgenden Dateien im UDF/HD-Modus•	
MPEG2 HD422–
MPEG2 HD420HQ–

Hinweise
Um mit „Content Browser Mobile“ Ausschnitte aus der •	
Originaldatei zu übertragen, zeichnen Sie die Proxy-Datei mit 
demselben Namen wie die Originaldatei und mit den 
folgenden Einstellungen auf.

Menü MAINTENANCE>Camera Config>SDI Rec Control>Para –
Rec
Menü MAINTENANCE>Camera Config>Match Clip Name>On–

Bei der Übertragung von Ausschnitten aus der Originaldatei •	
können folgende Funktionen nicht ausgeführt werden.

Clipfunktionen–
Formatieren von Medien–
Herstellen einer Verbindung zum PC über USB–

Beim Übertragen von Ausschnitten aus der Originaldatei dauert •	
das Speichern von Bildern im Bildpufferspeicher der 
Bildpufferaufzeichnungsfunktion nicht so lange wie in Menü 
OPERATION>Rec Function>P. Cache Rec Time eingestellt.

Statusanzeige für Einstellungen der Wi-Fi-Fernbedienung 
neu hinzugekommen
Die Einstellanzeige für Wi-Fi Setting>Wi-Fi Remote im Menü 
MAINTENANCE wurde zum Statusbildschirm für belegbare 
Schalter/Fernbedienung hinzugefügt.

Wi-Fi-Menü
Bei einer Verbindung über den WLAN-Adapter CBK-WA101 
(optional) können Sie Wi-Fi Setting>Wi-Fi und Wi-Fi Setting>Wi-Fi 
Remote im Menü MAINTENANCE einstellen.

Bildschirmanzeige neu hinzugekommen
Der folgende Status kann auf dem Sucherbildschirm angezeigt 
werden, wenn der WLAN-Adapter CBK-WA101 (optional) 
angeschlossen wird.

Der Status der verkabelten LAN-Verbindung mit dem WLAN-•	
Adapter CBK-WA101 (optional) wird angezeigt.
Der Verbindungsstatus des Netzwerk-Client-Modus wird •	
angezeigt.
Der Streaming-Status wird angezeigt.•	



   

Wichtige in V1.5 aktualisierte Funktionen
Videoformate
Der PMW-400/580 ist kompatibel mit dem MPEG2-
Aufnahmeformat im exFAT-Modus.

SD kann nun im exFAT-Modus in „HD/SD“ unter „Format“ im •	
Menü OPERATION ausgewählt werden.
„29.97P“, „23.98P“ und „25P“ sind nun im exFAT/HD/720-Modus •	
wählbare Optionen für „System Frequency“ unter „Format“ im 
Menü OPERATION.
„HD422“, „HQ“ und „DVCAM“ sind nun im exFAT-Modus wählbare •	
Optionen für „Rec Format“ unter „Format“ im Menü OPERATION.

Wichtige in V1.4 aktualisierte Funktionen
Videoformate
Der PMW-400/580 ist kompatibel mit dem Format XAVC Long 
GOP (XAVC-L).

„XAVC-L 50“, „XAVC-L 35“ und „XAVC-L 25“ sind nun im exFAT-•	
Modus wählbare Optionen für „Rec Format“ unter „Format“ im 
Menü OPERATION.

Der PMW-400/580 ist kompatibel mit der Versionsanzeige der 
CBK-CE01.

„CBK-CE01“ wurde unter „Version“ im Menü MAINTENANCE •	
hinzugefügt.

Wichtige in V1.3 aktualisierte Funktionen
Videoformate
Der PMW-400/580 ist kompatibel mit dem Format XAVC Intra-
Frame (XAVC-I).

„exFAT“ ist nun eine wählbare Option für „File System“ unter •	
„Format“ im Menü OPERATION. Wenn „exFAT“ ausgewählt wird, 
wird „XAVC-I“ automatisch eingestellt.

Wichtige in V1.22 aktualisierte Funktionen
Funktionen wurden verbessert.

Bei Anschluss einer HXCU-FB70 ist die Taste HXCU-FB70 PRESET •	
(Weißabgleichvoreinstellung) aktiviert.
CA erscheint jetzt im Menü MAINTENANCE •	
->Genlock>Reference.
Aufgrund von Verbesserungen erscheint NDF nicht mehr in der •	
Statusanzeige der monochromen LCD-Anzeige, wenn Country 
auf PAL gesetzt ist.
Die Videoformatanzeige im Sucherbildschirm, wenn HD420 •	
HQ1920 im UDF-Format auf Rec Format eingestellt wurde, 
wurde verbessert.

Wichtige in V1.2 aktualisierte Funktionen
USB-Medienanschlussfunktion
Clips auf externen Speichermedien mit einer USB-Schnittstelle 
(zum Beispiel Festplatte oder Flashlaufwerk) können kopiert oder 
wiedergegeben werden, wenn das Speichermedium am 
Anschluss OPTION angeschlossen wird.

USB Set wurde im Menü MAINTENANCE hinzugefügt. Mithilfe •	
dieser Menüoption können Sie ein USB-Medium bedienen.
Auf SxS-Speicherkarten gespeicherte Clips können jetzt auf •	
externe(n) Speichermedien kopiert und gesichert werden. 
Clips auf externen Speichermedien können jetzt auf SxS-•	
Speicherkarten kopiert werden. 
Clips auf externen Speichermedien können jetzt direkt •	
wiedergegeben werden. 

Hinweise
Externe Speichergeräte, die von einer Stromquelle mit •	
5,0 V/0,5 A versorgt werden, werden unterstützt. Das Gerät kann 
andere Speichergeräte möglicherweise nicht erkennen. 

Verwenden Sie in solchen Fällen eine separate Stromquelle für 
das Speichergerät. 
Es wird nicht garantiert, dass jedes beliebige Speichermedium •	
verwendet werden kann. Informationen zu Speichermedien, 
deren Eignung mit dem Gerät geprüft wurde, erhalten Sie in 
dem Geschäft, in dem Sie den Recorder gekauft haben. 
Formatieren Sie das USB-Medium vor dem Gebrauch mit •	
„Format USB“ im Menü des Camcorders.

Kameraadapter
Wenn der Kameraadapter angebracht ist, werden jetzt 
Umschaltfunktionen für das innere Bedienfeld unterstützt.

Mit dem Menübefehl MAINTENANCE >Camera Config >CCU •	
Operation können Sie die Umschaltfunktion auf Normal oder 
Local (deaktiviert oder aktiviert) stellen.

Hinweise
Wenn Sie die Einstellung für die Schalterfunktion der •	
Haupteinheit ändern, wird das Gerät automatisch neu gestartet.
Wenn die Schalterfunktion der Haupteinheit aktiviert ist, sind •	
die Anzeige an der CCU-Fernbedienung und die Rückvideo-
Anzeige sowie Tally- und Ruffunktionen von der CCU aus 
aktiviert, die Fernbedienung über den Anschluss REMOTE oder 
CCU jedoch deaktiviert.

Bildfehlerkorrektur
Die Funktion zur Bildfehlerkorrektur wurde verbessert.

Wichtige in V1.1 aktualisierte Funktionen
Flashband-Reduzierung
Der PMW-400/580 ist mit der Flashband-Reduzierung kompatibel.

Sie können die Flashband-Reduzierung unter „Flashband •	
Reduce“ im Menü OPERATION ein- bzw. ausschalten.
Das Ein- bzw. Ausschalten der Flashband-Reduzierung können •	
Sie unter „Assignable SW“ im Menü OPERATION einer frei 
belegbaren Taste zuweisen.
Sie können die Statusanzeige für die Flashband-Reduzierung •	
über „Flashband Reduce“ unter „Display On/Off“ im Menü 
OPERATION ein- bzw. ausschalten.

Hinweise
Beim Einstellen der Flashband-Reduzierung auf „On“ bzw. „Off“ •	
kann es zu Bild- und Tonverzerrungen kommen.
Wenn „Shutter“ auf „On“ eingestellt wird, während die •	
Flashband-Reduzierung auf „On“ eingestellt ist, wird die 
Flashband-Reduzierung automatisch auf „Off“ eingestellt.
Die Flashband-Reduzierung kann nicht auf „On“ eingestellt •	
werden, wenn sich der Camcorder im Bildpuffer-Modus, im 
Zeitlupen- & Zeitraffermodus oder im Modus für langsamen 
Blendenverschluss befindet oder i.LINK-Signale ausgegeben 
werden.
Die Flashband-Reduzierung wird auf „Off“ eingestellt, wenn der •	
Camcorder neu gestartet wird. Stellen Sie die Funktion danach 
wieder auf „On“ ein.

Menüs und Meldungen in mehreren Sprachen (nur PMW-
400)
Menüs und Meldungen können in Spanisch, Portugiesisch, 
Russisch und Indonesisch angezeigt werden. Meldungen können 
außerdem in Japanisch angezeigt werden.
„Japanese“, „Spanish“, „Portuguese“, „Russian“ u nd „Indonesian“ 
stehen jetzt unter „Language“ im Menü MAINTENANCE zur 
Auswahl.
Hinweis

Wenn Sie „Japanese“ wählen, werden die Menüs in Englisch und •	
die Meldungen in Japanisch angezeigt.



   

Drahtlos-Adapter
Der PMW-400/580 ist mit dem optionalen Drahtlos-Adapter 
CBK-WA101 kompatibel.

Für die synchronisierte Aufnahme können Sie „SDI Rec Control“ •	
unter „Camera Config“ im Menü MAINTENANCE auf „Para Rec“ 
einstellen.
Sie können die Funktion zum Abgleich der Clipnamen bei •	
synchronisierten Aufnahmen über „Match Clip Name“ unter 
„Camera Config“ im Menü MAINTENANCE ein- bzw. ausschalten.
Sie können die Statusanzeige für den Drahtlos-Adapter über •	
„Wireless Status“ unter „Display On/Off“ im Menü OPERATION 
ein- bzw. ausschalten.
Sie können die Anzeige der verbleibenden Aufnahmezeit für •	
eine SD-Karte, die in den Drahtlos-Adapter eingesetzt ist, über 
„Ext Media Remain“ unter „Display On/Off“ im Menü OPERATION 
ein- bzw. ausschalten.
Sie können die Anzeige des Status beim Hochladen von Clips •	
über den Drahtlos-Adapter über „Sending Clip Info“ unter 
„Display On/Off“ im Menü OPERATION ein- bzw. ausschalten.

Hinweise
Die Wi-Fi-Funktionen des Wi-Fi-Adapters CBK-WA01 oder des •	
USB-WLAN-Moduls IFU-WLM3 stehen nicht zur Verfügung, 
wenn der Drahtlos-Adapter angeschlossen ist.
 „Para Rec“ kann in den Spezialaufnahmemodi nicht eingestellt •	
werden. Für „Para Rec“ können die folgenden Videoformate 
verwendet werden. 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

USB-WLAN-Modul
Der PMW-400/580 ist mit dem optionalen USB-WLAN-Modul 
IFU-WLM3 für Wi-Fi-Verbindungen kompatibel.
Hinweise

Für die Einstellung von „Scan Networks“ unter „Wi-Fi Setting“ im •	
Menü MAINTENANCE werden nur „SSID“ und „Ch“ in der Liste 
NETWORK SCAN angezeigt. Wählen Sie die Verbindung aus und 
stellen Sie „Network Type“ unter „Wi-Fi Setting“ im Menü 
MAINTENANCE dann erneut ein.
Wenn „Network Type“ auf „Adhoc“ eingestellt ist, wird „Wi-Fi •	
Status“ unter „Wi-Fi Setting“ im Menü MAINTENANCE grau 
angezeigt und der Verbindungsstatus wird nicht angezeigt.

Videoformate
Der PMW-400/580 ist mit dem Aufnahmeformat UDF (MXF) 
HD420 35 Mbps 1920×1080 kompatibel. 

„HD420 HQ1920“ wurde zu den im UDF/HD/1080-Modus für •	
„Rec Format“ unter „Format“ im Menü OPERATION auswählbaren 
Optionen hinzugefügt.

ALAC-Funktion (Bildfehlerkorrektur)
Der PMW-400/580 unterstützt die ALAC-Funktion, wobei die 
Funktion auch ausgeschaltet werden kann. Der jeweilige Status 
wird angezeigt.

Sie können die ALAC-Funktion über „ALAC“ unter „Camera •	
Config“ im Menü MAINTENANCE ein- bzw. ausschalten. Die 
ALAC-Funktion lässt sich über den Anschluss REMOTE 
fernsteuern.
Sie können die ALAC-Statusanzeige über „ALAC“ unter „Display •	
On/Off“ im Menü OPERATION ein- bzw. ausschalten. „ALAC“ 
erscheint auf der Sucheranzeige, wenn die ALAC-Statusanzeige 
und die ALAC-Funktion auf „On“ bzw. „Auto“ eingestellt sind, 
und das ALAC-kompatible Objektiv führt eine 
Farbfehlerkorrektur durch.

Hinweis
„ALAC“ wird nicht angezeigt, wenn keine Farbfehlerkorrektur •	
erfolgt, selbst wenn ein ALAC-kompatibles Objektiv an den 
Camcorder angebracht ist. Kalibrieren Sie das Objektiv in 
diesem Fall entsprechend.

Italiano

Nota di rilascio
Principali funzioni aggiornate con V1.7
Aggiunta la schermata di stato RECENT FILES
La schermata di stato visualizza le informazioni sui file (fino a 15) 
caricati di recente sull’elenco nell’ordine di caricamento.
Nella schermata di stato RECENT FILES, è possibile visualizzare 
sull’elenco fino a 15 file di informazioni (fino a 3 per il file User, file 
All, file Scene, file Reference o file Lens).
Sono visualizzati la data e l’ora a cui è stato caricato il file, il tipo di 
file, il tipo di supporto e il nome di file.

Registrazione del menu di personalizzazione file nel menu 
USER
Le voci seguenti nel menu FILE possono essere registrate nel 
menu USER.

FILE > User > User Load SxS•	
  > User Save SxS
  > User Load USB
  > User Save USB
  > File ID
  > Recall User Preset

FILE > All > All Load SxS•	
  > All Save SxS
  > All Load USB
  > All Save USB
  > All Preset

FILE > Scene > Scene Recall SxS•	
  > Scene Store SxS
  > Scene Recall USB
  > Scene Store USB

Disabilitata l’impostazione assegnabile con il menu 
bloccato
Se una voce di menu non registrata nel menu USER viene 
assegnata ad “Assignable SW” mentre il menu è bloccato, 
l’impostazione assegnabile viene disattivata.
Questa funzione è utile quando non si desidera cambiare una 
impostazione di menu diversa dal menu USER.
Nota

Se il menu è bloccato mentre le voci del menu di impostazione 
elencato di seguito non sono registrate nel menu USER, la 
funzione della voce di menu non può essere assegnata ad 
“Assignable SW”.

Voci del menu di 
impostazione

Voci di menu che è 
possibile assegnare ad 
“Assignable SW”

OPERATION > Rec Function > 
Picture Cache Rec Picture Cache

OPERATION > Rec Function > 
Clip Continuous Rec Clip Continuous Rec



   

OPERATION > VF Setting > 
Mode EVF Mode

OPERATION > Display On/
Off > Brightness Display BRT Disp

OPERATION > Display On/
Off > Histogram Display Histogram

OPERATION > Display On/
Off > Lens Info Lens Info

OPERATION > TLCS > Mode
Spotlight

Backlight

OPERATION > TLCS > AGC*

EZ ModeOPERATION > TLCS > Auto 
Shutter*

OPERATION > Marker > 
Setting Marker

MAINTENANCE > Audio > 
Front MIC Select Front Mic

Anche se “AGC” o “Auto Shutter” non è registrato nel menu USER, * 
“EZ Mode” non può essere selezionato da “Assignable SW”.

La registrazione di un supporto SxS è stata migliorata
La durata massima di registrazione di un supporto SxS per la 
registrazione di più clip è stata migliorata.

Funzioni principali aggiornate con V1.6
Formato video
La registrazione IMX è supportata in modalità exFAT.

IMX50 è stato aggiunto alla voce di impostazione di menu per •	
OPERATION>Format>Rec Format in modalità exFAT/SD.

Aggiunta del menu USER
È stato aggiunto il menu USER che consente di registrare le voci 
utilizzate più spesso nei menu OPERATION, PAINT o 
MAINTENANCE nel menu USER. È possibile effettuare la 
registrazione nel menu USER MENU CUSTOMIZE.

Aggiunta della funzione di blocco menu
È stata aggiunta la funzione per bloccare il menu di impostazione 
e visualizzare solo il menu USER.

Tenere premuto la manopola MENU e premere l’interruttore •	
MENU ON/OFF contemporaneamente per visualizzare il menu 
di impostazione e immettere la password in User Menu with 
Lock>On per bloccare la visualizzazione del menu e visualizzare 
solo il menu USER. 
Questa funzione è utile quando non si desidera modificare le 
impostazioni di menu diverse da quelle nel menu USER.
Per annullare il blocco e visualizzare di nuovo tutti gli elenchi di •	
menu, tenere premuto la manopola MENU e premere 
contemporaneamente l’interruttore MENU ON/OFF per 
visualizzare il menu di impostazione, quindi immettere la stessa 
password immessa quando si è bloccato il menu.

Nota

Si consiglia di conservare la password per utilizzo futuro. Se si 
dimentica la password, rivolgersi a un rappresentante 
dell’assistenza Sony.

Registrazione simultanea nei 2 slot
È supportata la registrazione simultanea nei 2 slot SxS.
Le funzioni possono essere attivate/disattivate da 
OPERATION>Rec Function>Simul Rec.
Sono supportati i formati seguenti:

I formati seguenti in modalità exFAT/HD•	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

I formati seguenti in modalità UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Note
Quando si utilizza la registrazione simultanea, utilizzare schede •	
di memoria dello stesso tipo e dimensione.
Non è possibile utilizzare la registrazione simultanea con le •	
seguenti funzioni in contemporanea:

Registrazione per fotogrammi–
Registrazione Clip continua–
Registrazione cache immagini–
Rallentatore e movimento rapido–
Registrazione a intervalli–

Il dispositivo IFU-WLM3 USB Wireless LAN Module non può •	
essere utilizzato durante la registrazione simultanea.

Supporta la scheda SDXC
Tramite un adattatore di supporti MEAD-SD02 opzionale, è 
possibile registrare e riprodurre una scheda SDXC.
È possibile utilizzare la scheda SDXC solo in modalità exFAT.
Scheda SDXC (SD Classe di velocità: 10)
Note

Quando si utilizza la scheda SDXC con questa unità, formattarla •	
utilizzando la funzione di formattazione dell’unità.
Con la scheda SDXC non è possibile ottenere correttamente la •	
riproduzione ad alta velocità.
Quando si utilizza una scheda SDXC, non utilizzare altri tipi di •	
schede di memoria contemporaneamente. Se si utilizzano 
contemporaneamente altri tipi di supporti, il passaggio all’altro 
supporto potrebbe non avvenire se il supporto non ha più 
spazio durante la registrazione.
La registrazione con il formato XAVC-I o la registrazione •	
rallentatore e movimento rapido potrebbero non essere 
eseguite correttamente in base alla scheda SDXC utilizzata. Si 
consiglia una scheda di memoria SxS.
Potrebbe non essere possibile utilizzare una scheda SDXC •	
registrata con la videocamera delle serie PMW e PXW per 
registrazione e riproduzione con questa unità in base al tipo di 
unità usata. Per informazioni, rivolgersi al rivenditore Sony o a 
un rappresentante dell’assistenza Sony.

Aggiunta del menu diretto
Quando il menu diretto è abilitato, è possibile modificare le 
impostazioni di visualizzazione delle voci nello schermo del 
mirino senza visualizzare i menu con l’interruttore MENU ON/OFF.
Il menu diretto è abilitato quando il menu MAINTENANCE>Direct 
Menu è impostato su On.
Abilitare l’impostazione del menu diretto e utilizzarlo tramite la 
manopola MENU. È possibile utilizzare le voci seguenti.

Impostazioni COLOR TEMP del bilanciamento del bianco•	
Impostazioni modalità per TLCS•	
Velocità otturatore dell’otturatore elettronico o impostazioni del •	
numero di fotogrammi accumulati
Impostazione velocità fotogrammi in modalità rallentatore e •	
movimento rapido



   

Note
Quando le voci del menu diretto non sono visualizzate nello •	
schermo del mirino (menu OPERATION>Display On/Off è 
impostato su Off ), non è possibile utilizzare tali voci con il menu 
diretto.
Queste sono le condizioni seguenti per abilitare il menu diretto •	
in base alle voci.

Impostazione COLOR TEMP del bilanciamento del bianco –
Quando l’interruttore WHITE BAL (commutazione della 
memoria di bilanciamento del bianco) è posizionato su “A” o “B” 
e quando l’interruttore WHITE BAL è posizionato su “B” mentre 
OPERATION>White Setting>White Switch<B>>Memory nel 
menu
Impostazione velocità otturatore dell’otturatore elettronico –
Tutte le modalità: 
L’interruttore SHUTTER è posizionato su ON. 
Modalità velocità: 
OPERATION>Shutter>Shutter Select>Second nel menu 
Modalità angolo: 
OPERATION>Shutter>Shutter Select>Degree nel menu 
Modalità ECS: 
La modalità ECS è impostata.
Impostazione numero fotogrammi accumulati dell’otturatore –
elettronico 
Modalità Slow Shutter: OPERATION>Shutter>Slow Shutter>On 
nel menu
Impostazione velocità fotogrammi in modalità rallentatore e –
movimento rapido 
OPERATION>Rec Function>Slow & Quick>On nel menu

Trasferimento parziale di un file originale registrato su 
questo apparecchio
È possibile trasferire un ritaglio di un file specificando opportuni 
punti IN e OUT nel file originale registrato da questo apparecchio. 
È possibile inoltre trasferire ritagli di più file utilizzando lo 
Storyboard.
Per i trasferimenti parziali sono richiesti i seguenti dispositivo e 
applicazione.

Collegare l’adattatore wireless CBK-WA101 (opzionale) a questa •	
videocamera.
Utilizzare l’applicazione Content Browser Mobile sul dispositivo •	
collegato tramite Wireless LAN a questa videocamera. (Utilizzare 
la versione più recente dell’applicazione “Content Browser 
Mobile”.)

Sono supportati i seguenti file originali:
I file seguenti in modalità exFAT/HD•	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

I file seguenti in modalità UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Note
Per trasferire parzialmente il file originale tramite “Content •	
Browser Mobile”, registrare il file proxy con lo stesso nome del 
file originale con le impostazioni seguenti.

Menu MAINTENANCE>Camera Config>SDI Rec Control>Para –
Rec
Menu MAINTENANCE>Camera Config>Match Clip Name>On–

Durante il trasferimento parziale del file originale, non è •	
possibile eseguire le operazioni seguenti.

Operazioni sui clip–
Formattazione supporti–
Connessione al PC tramite USB–

Durante il trasferimento parziale del file originale, il tempo per •	
memorizzare le immagini nella memoria cache immagini della 
registrazione cache immagini è minore di quanto impostato nel 
menu OPERATION>Rec Function>P. Cache Rec Time

Aggiunta della visualizzazione di stato delle impostazioni 
di controllo remoto Wi-Fi
La visualizzazione dell’impostazione di Wi-Fi Setting>Wi-Fi 
Remote nel menu MAINTENANCE è stata aggiunta alla schermata 
di stato remoto/interruttori programmabili.

Menu Wi-Fi
Quando si collega tramite adattatore remoto CBK-WA101 
(opzionale), è possibile impostare Wi-Fi Setting>Wi-Fi e Wi-Fi 
Setting>Wi-Fi Remote nel menu MAINTENANCE.

Aggiunta della visualizzazione schermo
È possibile visualizzare lo stato seguente nello schermo del 
mirino quando è collegato l’adattatore wireless CBK-WA101 
(opzionale).

Visualizza lo stato della connessione LAN cablata alla •	
visualizzazione di stato dell’adattatore wireless CBK-WA101 
(opzionale).
Visualizza lo stato di connessione della modalità client di rete.•	
Visualizza lo stato di streaming.•	

Funzioni principali aggiornate con V1.5
Formati video
PMW-400/580 è compatibile con il formato di registrazione 
MPEG2 in modalità exFAT.

SD ora è selezionabile in “HD/SD” nel “Format” del menu •	
OPERATION in modalità exFAT.
“29.97P”, “23.98P” e “25P” sono aggiunte fra le voci selezionabili di •	
“System Frequency” nel “Format” del menu OPERATION in 
modalità exFAT/HD/720.
“HD422”, “HQ” e “DVCAM” sono aggiunte fra le voci selezionabili •	
di “Rec Format” nel “Format” del menu OPERATION in modalità 
exFAT.

Funzioni principali aggiornate con V1.4
Formati video
PMW-400/580 è compatibile con il formato di XAVC Long GOP 
(XAVC-L).

“XAVC-L 50”, “XAVC-L 35” e “XAVC-L 25” sono aggiunte tra le voci •	
selezionabili di “Rec Format” nel “Format” del menu OPERATION 
in modalità exFAT.

PMW-400/580 è compatibile con la vista della versione CBK-CE01.
“CBK-CE01” viene aggiunto come “Version” del menu •	
MAINTENANCE.

Funzioni principali aggiornate con V1.3
Formati video
La PMW-400/580 è compatibile con il formato di XAVC intra-
fotogramma (XAVC-I).

“exFAT” viene aggiunto per le voci selezionabili di “File System” in •	
“Format” del menu OPERATION. Quando è selezionato “exFAT”, 
“XAVC-I” viene impostato automaticamente.

Funzioni principali aggiornate con V1.22
Funzioni migliorate.

Quando unito a HXCU-FB70, il pulsante HXCU-FB70 PRESET •	
(preset bilanciamento del bianco) è abilitato.
CA è ora visualizzato nel menu MAINTENANCE ->Genlock> •	
Reference.



   

Sono stati introdotti miglioramenti in modo che NDF non •	
venga visualizzato sull’area di stato del pannello LCD 
monocromatico quando Country è impostato su PAL.
Sono stati introdotti miglioramenti alla visualizzazione del •	
formato video sullo schermo del mirino, quando HD420 
HQ1920 è impostato su Rec Format in modalità UDF.

Funzioni principali aggiornate con V1.2
Funzioni della connessione supporto di memoria USB
Sono supportate la copia e la riproduzione di clip contenuti su un 
dispositivo di memorizzazione esterno con interfaccia USB, ad 
esempio un disco rigido o una memoria flash, connesso al 
connettore OPTION. 

È stata aggiunta la voce USB Set al menu MAINTENANCE. È •	
possibile controllare un supporto USB mediante questa voce di 
menu.
È possibile ora copiare ed eseguire backup su supporti di •	
memoria esterni dei clip memorizzati su schede di memoria 
SxS.
È possibile ora copiare su schede di memoria SxS i clip •	
memorizzati su supporti di memorizzazione esterni. 
È possibile ora riprodurre direttamente i clip memorizzati su •	
supporti di memorizzazione esterni.

Note
Sono supportati dispositivi di memorizzazione esterni che •	
richiedono alimentazione a 5,0 V/0,5 A. L’unità potrebbe non 
riconoscere dispositivi di memorizzazione diversi. In tal caso, 
alimentare il dispositivo di memorizzazione con una fonte di 
alimentazione separata. 
Non è possibile garantire il funzionamento con tutti i supporti •	
di memorizzazione. Per informazioni sui supporti di 
memorizzazione di cui è stato verificato il funzionamento 
corretto con il registratore, rivolgersi al rivenditore presso cui è 
stato acquistato. 
Prima di utilizzare un supporto USB, formattarlo tramite Format •	
USB nel menu della videocamera.

Adattatore camcorder
Sono ora supportate le operazioni di commutazione dal pannello 
interno quando è montato l’adattatore camcorder.

La voce di menu MAINTENANCE >Camera Config >CCU •	
Operation consente di impostare la modalità operativa della 
commutazione dell’unità principale su Normal o Local (ovvero, 
disabilitata o abilitata).

Note
Se si modifica la modalità di commutazione dell’unità •	
principale, l’unità si riavvia automaticamente.
Se è abilitata la modalità di commutazione dell’unità principale, •	
saranno abilitate la visualizzazione sul comando a distanza della 
CCU, la visualizzazione dei video di ritorno e le operazioni di 
tally e chiamata, ma il comando a distanza tramite la CCU o 
tramite il connettore REMOTE è disabilitato.

Funzione di compensazione dell’aberrazione
La funzione di compensazione dell’aberrazione è stata 
ottimizzata.

Funzioni principali aggiornate con V1.1
Funzione di riduzione banda flash
La PMW-400/580 è compatibile con la funzione di riduzione 
banda flash.

È possibile attivare/disattivare la funzione di riduzione banda •	
flash in “Flashband Reduce” del menu OPERATION. 

L’operazione di attivazione/disattivazione della riduzione banda •	
flash può essere assegnata al tasto programmabile in 
“Assignable SW” del menu OPERATION.
È possibile attivare/disattivare l’indicazione di stato di riduzione •	
banda flash da “Flashband Reduce” in “Display On/Off” del menu 
OPERATION.

Note
Video e audio possono essere distorti quando la funzione di •	
riduzione banda flash è impostata su “On” o “Off”.
Quando “Shutter” è impostato su “On” mentre la funzione di •	
riduzione banda flash è impostata su “On”, la funzione di 
riduzione banda flash viene impostata automaticamente su 
“Off”.
La funzione di riduzione banda flash non può essere impostata •	
su “On” quando la videocamera è in modalità cache immagine, 
modalità di registrazione S&Q, modalità di otturazione lenta o si 
emette i.LINK.
La funzione di riduzione banda flash viene impostata su “Off” al •	
riavvio della videocamera. Impostare di nuovo la funzione su 
“On”.

Menu multi lingue e messaggio (solo PMW-400)
Sono disponibili messaggi e menu in spagnolo, portoghese, 
russo e indonesiano. Inoltre, sono disponibili i messaggi in 
giapponese.
“Japanese”, “Spanish”, “Portuguese”, “Russian” e “Indonesian” sono 
aggiunti in “Language” del menu MAINTENANCE.
Nota

I menu sono visualizzati in inglese e i messaggi in giapponese •	
quando si seleziona “Japanese”.

Adattatore wireless
La PMW-400/580 è compatibile con l’adattatore wireless 
opzionale CBK-WA101.

È possibile impostare “SDI Rec Control” in “Camera Config” del •	
menu MAINTENANCE su “Para Rec” per consentire la 
registrazione sincronizzata.
È possibile attivare/disattivare la funzione di corrispondenza del •	
nome di clip durante la registrazione sincronizzata in “Match 
Clip Name” in “Camera Config” del menu MAINTENANCE.
È possibile attivare/disattivare l’indicazione di stato wireless •	
dell’adattatore wireless con “Wireless Status” in “Display On/Off” 
del menu OPERATION.
È possibile attivare/disattivare l’indicazione del tempo •	
rimanente di una scheda SD inserita nell’adattatore wireless con 
“Ext Media Remain” in “Display On/Off” del menu OPERATION. 
È possibile attivare/disattivare l’indicazione di stato caricamento •	
clip tramite l’adattatore wireless da “Sending Clip Info” in “Display 
On/Off” del menu OPERATION.

Note
Le funzioni Wi-Fi dell’adattatore Wi-Fi CBK-WA01 o del modulo •	
LAN wireless USB IFU-WLM3 non sono disponibili quando è 
connesso l’adattatore wireless.
“Para Rec” non può essere impostato nelle modalità di •	
registrazione speciali. È possibile utilizzare i seguenti formati 
video per “Para Rec”. 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

Modulo LAN wireless USB
La PMW-400/580 è compatibile con il modulo LAN wireless USB 
opzionale IFU-WLM3 che consente la connessione Wi-Fi.



   

Note
Per l’impostazione di “Scan Networks” in “Wi-Fi Setting” del menu •	
MAINTENANCE, solo “SSID” e “Ch” compaiono nell’elenco 
NETWORK SCAN. Impostare di nuovo “Network Type” in “Wi-Fi 
Setting” del menu MAINTENANCE dopo aver selezionato la 
connessione.
Quando “Network Type” è impostato su “Adhoc”, “Wi-Fi Status” in •	
“Wi-Fi Setting” del menu MAINTENANCE appare in grigio e lo 
stato della connessione non viene visualizzato.

Formati video
La PMW-400/580 è compatibile con il formato di registrazione 
UDF (MXF) HD420 35 Mbps 1920×1080. 

“HD420 HQ1920” aggiunto per le voci selezionabili di “Rec •	
Format” in “Format” del menu OPERATION in modalità UDF/
HD/1080.

Funzione ALAC (Correzione dell’aberrazione)
La PMW-400/580 è compatibile con la funzione ALAC ed è in 
grado di disattivare tale funzione. Inoltre, lo stato viene 
visualizzato di conseguenza.

È possibile attivare/disattivare la funzione ALAC da “ALAC” in •	
“Camera Config” del menu MAINTENANCE. È possibile operare la 
funzione ALAC da remoto tramite il connettore REMOTE.
È possibile attivare/disattivare l’indicazione di stato ALAC da •	
“ALAC” in “Display On/Off” del menu OPERATION. “ALAC” appare 
nello schermo del mirino quando l’indicazione di stato ALAC e 
la funzione ALAC sono impostate su “On” e “Auto” 
rispettivamente e l’aberrazione è corretta da un obiettivo ALAC 
compatibile.

Nota
“ALAC” non viene visualizzato senza correzione dell’aberrazione •	
anche quando alla videocamera è fissato un obiettivo ALAC 
compatibile. In questo caso, calibrare opportunamente 
l’obiettivo.

Español

Nota de la versión
Principales funciones actualizadas con la V1.7
Introducción de la pantalla de estado RECENT FILES
La pantalla de estado muestra información de los archivos 
(hasta 15) cargados recientemente en la lista en el orden de 
carga.
En la pantalla de estado RECENT FILES puede ver en la lista la 
información de hasta 15 archivos (hasta 3 en cada caso para los 
archivos Usuario, Todos, Escena, Ref. o Lente).
Aparecen la fecha y la hora de carga del archivo, el tipo de 
archivo, el tipo de soporte y el nombre de archivo.

Registro del menú de personalización de archivo en el 
menú USUARIO
Los siguientes elementos del menú ARCHIVO pueden registrarse 
en el menú USUARIO.

ARCHIVO > Usuario•	
  > Cargar usuario SxS
  > Guardar usuario SxS
  > Cargar usuario USB
  > Guardar usuario USB
  > ID de archivo
  > Recuperar preaj. usu.

ARCHIVO > Todos•	
  > Cargar todo SxS
  > Guardar todo SxS
  > Cargar todo USB
  > Guardar todo USB
  > Todos preest.

ARCHIVO > Escena•	
  > Cargar escena SxS
  > Almace.escena SxS
  > Cargar escena USB
  > Almace.escena USB

Desactivación del ajuste asignable con el menú bloqueado
Si un elemento del menú no registrado en el menú USUARIO se 
asigna “Inter. asig.” mientras el menú está bloqueado, se desactiva 
el ajuste asignable.
Esta función resulta útil si no desea modificar otros ajustes de 
menús diferentes del menú USUARIO.
Nota

Si el menú está bloqueado mientras los elementos del menú del 
menú de configuración enumerados a continuación no están 
registrados en el menú USUARIO, la función del elemento del 
menú no puede asignarse a “Inter. asig.”.

Elementos del menú del 
menú de configuración

Elementos del menú que 
pueden asignarse a “Inter. 
asig.”

OPERAC. > Func. grab. > 
Caché de imágenes Caché de imágenes

OPERAC. > Func. grab. > 
Grab. continua clip Grab. continua clip

OPERAC. > Conf. visor > 
Modo Modo EVF

OPERAC. > Pantalla On/Off > 
Ver nivel de brillo Ver nivel de brillo

OPERAC. > Pantalla On/Off > 
Histograma Histograma

OPERAC. > Pantalla On/Off > 
Info. lente Info. lente

OPERAC. > TLCS > Modo
1r plano

Retroilum.

OPERAC. > TLCS > AGC*

Modo EZOPERAC. > TLCS > Obturador 
auto*

OPERAC. > Marcador > Conf. Marcador

MANTENIM. > Audio > Selec. 
micr. frontal Micrófono frontal

Aunque “AGC” u “Obturador auto” no estén registrados en el * 
menú USUARIO, “Modo EZ” no puede seleccionarse con “Inter. 
asig.”.



   

Mejora en el tiempo de grabación de un soporte SxS
El tiempo de grabación máximo de un soporte SxS para la 
grabación de varios clips ha mejorado.

Principales funciones actualizadas con V1.6
Formato de vídeo
La grabación IMX es compatible con el modo exFAT.

IMX50 se ha añadido a las opciones de ajuste del menú •	
OPERAC.>Formato>Form. grab. en el modo exFAT/SD.

Nuevo menú Usuario añadido
Hemos añadido el menú Usuario y ahora es posible registrar las 
opciones más utilizadas de los menús OPERAC., C.IMAG. o 
MANTENIM. en el menú Usuario. Para registrar las opciones, hay 
que utilizar el menú PERSON. MENÚ USUARIO.

Nueva función para bloquear menú
Se ha añadido una función que permite bloquear el menú de 
configuración y mostrar solo el menú Usuario.

Mantenga pulsado el control MENU y pulse el interruptor MENU •	
ON/OFF al mismo tiempo para mostrar el menú de 
configuración y, después, introduzca la contraseña en User 
Menu with Lock>On para bloquear la pantalla del menú y 
mostrar solo el menú Usuario. 
Esta función es útil cuando no desea modificar ajustes del menú 
aparte de los que forman parte del menú Usuario.
Para cancelar el bloqueo y volver a mostrar todas las listas de •	
menús, mantenga pulsado el control MENU y pulse el 
interruptor MENU ON/OFF al mismo tiempo para mostrar el 
menú de configuración y, después, introduzca la misma 
contraseña utilizada para bloquear el menú.

Nota

Se recomienda apuntar la contraseña para poder consultarla más 
adelante. Si olvida la contraseña, póngase en contacto con un 
representante del servicio de asistencia de Sony.

Grabación simultánea en 2 ranuras
El sistema admite la grabación simultánea usando 2 ranuras SxS.
Las funciones pueden activarse/desactivarse desde 
OPERAC.>Func. grab.>Grabación simultánea.
Se admiten los siguientes formatos:

Los siguientes formatos en el modo exFAT/HD•	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Los siguientes formatos en el modo UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Notas
Al utilizar la grabación simultánea, use tarjetas de memoria del •	
mismo tipo y tamaño.
La grabación simultánea no puede utilizarse con las siguientes •	
funciones al mismo tiempo:

Grabación de fotogramas–
Grabación continua de clips–
Grabación de caché de imágenes–
Movimiento a cámara lenta y rápida–
Grabación a intervalos–

El USB Wireless LAN Module IFU-WLM3 no se puede utilizar •	
durante la grabación simultánea.

Compatibilidad con la tarjeta SDXC
Utilizando un adaptador de soportes MEAD-SD02 opcional, es 
posible grabar contenidos en una tarjeta SDXC y reproducirlos.
La tarjeta SDXC solo puede utilizarse en el modo exFAT.

Tarjeta SDXC (clasificación de velocidad SD: 10)
Notas

Al usar la tarjeta SDXC con esta unidad, formatéela utilizando la •	
función de formateo de la unidad.
La reproducción a alta velocidad no siempre ofrece unos •	
resultados óptimos con una tarjeta SDXC.
Al usar una tarjeta SDXC, no utilice otros tipos de tarjetas de •	
memoria simultáneamente. Si utiliza otros tipos de soportes al 
mismo tiempo, no es posible acceder a otros soportes en caso 
de falta de espacio durante la grabación.
La grabación con el formato XAVC-I y la grabación con •	
movimiento a cámara lenta y rápida no siempre se realizarán 
correctamente, en función de la tarjeta SDXC utilizada. Se 
recomienda usar una tarjeta de memoria SxS.
Una tarjeta SDXC utilizada para grabar con la videocámara de •	
las series PMW y PXW tal vez no pueda utilizarse para la 
grabación y la reproducción con esta unidad, en función del 
tipo de unidad utilizado. Para obtener más información, 
póngase en contacto con su distribuidor Sony o con un 
representante del servicio de asistencia de Sony.

Nuevo menú directo añadido
Cuando está activado el menú directo, es posible modificar 
ajustes en opciones mostradas en la pantalla del visor sin mostrar 
los menús con el interruptor MENU ON/OFF.
El menú directo está activado cuando el menú 
MANTENIM.>Menú directo está ajustado en On.
Active el menú directo y utilícelo directamente con el control 
MENU. Pueden utilizarse las siguientes opciones.

Los ajustes de COLOR TEMP del balance de blancos•	
Los ajustes de modo de TLCS•	
La velocidad de obturación del obturador electrónico o los •	
ajustes del número de fotogramas acumulados
El ajuste de velocidad de fotogramas en el modo Movimiento a •	
cámara lenta y rápida

Notas
Si las opciones del menú directo no aparecen en la pantalla del •	
visor (menú OPERAC.>Pantalla On/Off ajustado en Off ), no es 
posible utilizar dichas opciones con el menú directo.
Estas son las condiciones que deben cumplirse para poder •	
activar el menú directo en función de las opciones.

Ajustes de COLOR TEMP del balance de blancos –
Cuando el interruptor de WHITE BAL (que controla la memoria 
del balance de blancos) está situado en “A” o “B” y cuando el 
interruptor WHITE BAL está situado en “B” mientras está 
seleccionado OPERAC.>Ajus. blanco>Interruptor 
blanco<B>>Memoria en el menú
Ajuste de la velocidad de obturación del obturador –
electrónico 
Todos los modos: 
Interruptor SHUTTER ajustado en ON. 
Modo de velocidad: 
OPERAC.>Obturador>Selec. obturador>Segundos en el menú 
Modo ángulo: 
OPERAC.>Obturador>Selec. obturador>Grados en el menú 
Modo ECS: 
Modo ECS configurado.
Ajustes del número de fotogramas acumulados del obturador –
electrónico 
Modo Obturador lento: OPERAC.>Obturador>Obturador 
lento>On en el menú
Ajuste de la velocidad de fotogramas en el modo Movimiento –
a cámara lenta y rápida 
OPERAC.>Func. grab.>Slow & Quick>On en el menú



   

Transferencia parcial de un archivo original grabado en 
esta unidad
Puede transferir una parte recortada de un archivo especificando 
los puntos de entrada y de salida en el archivo original grabado 
por esta unidad. 
Además, puede transferir las partes recortadas de varios archivos 
utilizando el Guión gráfico.
Para las transferencias parciales, es necesario utilizar el dispositivo 
y la aplicación siguientes.

Conecte el adaptador inalámbrico CBK-WA101 (opcional) a esta •	
videocámara.
Utilice la aplicación Content Browser Mobile del dispositivo •	
conectado a través de Wireless LAN con esta videocámara. 
(Utilice la última versión de la aplicación “Content Browser 
Mobile”.)

Se admiten los siguientes tipos de archivos originales:
Los siguientes archivos en el modo exFAT/HD•	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Los siguientes archivos en el modo UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Notas
Para transferir parcialmente el archivo original con “Content •	
Browser Mobile”, grabe el archivo de proxy con el mismo 
nombre de archivo que el archivo original utilizando los 
siguientes ajustes.

Menú MANTENIM.>Conf. cámara>Control grab. SDI>G.simul–
Menú MANTENIM.>Conf. cámara>Coincid. nombre clip>On–

Durante la transferencia parcial del archivo original, no pueden •	
realizarse las siguientes operaciones.

Operaciones con clips–
Formateo de soportes–
Conexión al PC a través de USB–

Al realizar una transferencia parcial del archivo original, el •	
tiempo necesario para guardar las imágenes en la memoria 
caché de imágenes de la grabación en caché de imágenes es 
inferior al tiempo definido en el menú OPERAC.>Func. 
grab.>Tiempo caché imágenes

Visualización de la información sobre el estado del ajuste 
del control Wi-Fi a distancia
La visualización del ajuste de Conf. Wi-Fi>Wi-Fi a distancia en el 
menú MANTENIM. se ha añadido a la pantalla de estado de los 
interruptores asignables/mando a distancia.

Menú Wi-Fi 
Al establecer la conexión con el adaptador inalámbrico CBK-
WA101 (opcional), puede ajustar Conf. Wi-Fi>Wi-Fi y Conf.  
Wi-Fi>Wi-Fi a distancia en el menú MANTENIM. 

Visualización de la pantalla de estado
Cuando el adaptador inalámbrico CBK-WA101 (opcional) está 
conectado, es posible mostrar los siguientes estados en la 
pantalla del visor.

Muestra el estado de la conexión LAN con cable con la •	
visualización del estado del adaptador inalámbrico CBK-WA101 
(opcional).
Muestra el estado de conexión del modo cliente de red.•	
Muestra el estado de la transmisión en streaming.•	

Principales funciones actualizadas con V1.5
Formatos de vídeo
La PMW-400/580 es compatible con el formato de grabación 
MPEG2 en el modo exFAT.

Ahora es posible seleccionar SD en “HD/SD” dentro de “Formato” •	
en el menú OPERAC. del modo exFAT.
“29.97P”, “23.98P” y “25P” se añaden a los elementos •	
seleccionables de la opción “Frec. sist.” dentro de “Formato” en el 
menú OPERAC. del modo exFAT/HD/720.
“HD422”, “HQ” y “DVCAM” se añaden a los elementos •	
seleccionables de la opción “Form. grab.” dentro de “Formato” en 
el menú OPERAC. del modo exFAT.

Principales funciones actualizadas con V1.4
Formatos de vídeo
La PMW-400/580 es compatible con el formato XAVC Long GOP 
(XAVC-L).

“XAVC-L 50”, “XAVC-L 35” y “XAVC-L 25” se añaden para los •	
elementos seleccionables de la opción “Form. grab.” de 
“Formato” en el menú OPERAC. en el modo exFAT.

La PMW-400/580 es compatible con la visualización de versiones 
de CBK-CE01.

“CBK-CE01” se añade a la opción “Versión” del menú MANTENIM.•	

Principales funciones actualizadas con V1.3
Formatos de vídeo
La PMW-400/580 es compatible con el formato de compresión 
espacial XAVC (XAVC-I).

“exFAT” se añade para los elementos seleccionables de la opción •	
“Arch. sist.” de “Formato” del menú OPERAC. Cuando se 
selecciona “exFAT”, “XAVC-I” se establece automáticamente.

Principales funciones actualizadas con V1.22
Se han mejorado determinadas funciones.

Unido al HXCU-FB70, se habilita el botón PRESET del HXCU-FB70 •	
(valor predeterminado de balance de blanco).
Aparece CA en el menú MANTENIM. ->Genlock>Referencia.•	
Las mejoras se han realizado para que NDF no aparezca en la •	
pantalla de estado del panel LCD monocromo si País está 
establecido en PAL.
Las mejoras se han realizado en la pantalla de formato de vídeo •	
de la pantalla del visor si HD420 HQ1920 se ha establecido en 
Form. grab. en el modo UDF.

Principales funciones actualizadas con V1.2
Función de conexión de soporte USB
El conector OPTION permite la copia y reproducción de clips en 
soportes de almacenamiento externos con una interfaz USB, 
como un disco duro o una unidad flash. 

Se ha añadido Conf. USB al menú MANTENIM. Puede operar un •	
soporte USB utilizando este elemento del menú.
Ahora es posible copiar y hacer copias de seguridad en •	
soportes de almacenamiento externos de los clips almacenados 
en tarjetas de memoria SxS. 
Ahora es posible copiar en tarjetas de memoria SxS los clips de •	
soportes de almacenamiento externos.
Ahora es posible reproducir directamente los clips de soportes •	
de almacenamiento externos. 

Notas
Ahora se admiten dispositivos de almacenamiento externos •	
que funcionen con una fuente de alimentación de 5,0 V/0,5 A. 
Puede que la unidad no reconozca otros dispositivos de 
almacenamiento. En esos casos, proporcione una fuente de 



   

alimentación independiente para el dispositivo de 
almacenamiento. 
No se garantiza el funcionamiento de todos los soportes. •	
Consulte con el establecimiento el que adquirió la grabadora 
sobre los soportes cuyo uso se ha comprobado en la unidad. 
Antes de usar un medio USB, formatéelo utilizando Formatear •	
USB en el menú de la videocámara.

Adaptador de la cámara
Ahora se admiten operaciones con el interruptor del panel 
interior cuando se encuentra instalado el adaptador de la cámara.

El elemento del menú MANTENIM. >Conf. cámara >Operación •	
CCU le permite ajustar el funcionamiento del interruptor de la 
unidad principal en Norm. o Local (por ejemplo, desactivado o 
activado).

Notas
Si cambia el ajuste del funcionamiento del interruptor de la •	
unidad principal, la unidad se reiniciará de forma automática.
Cuando se activa el funcionamiento del interruptor de la unidad •	
principal, se activa la visualización del controlador remoto de 
CCU, la visualización de vídeo de retorno y las operaciones de 
recuento y llamada desde la CCU, pero se desactiva el control 
remoto a través de la CCU o el conector REMOTE.

Función de compensación de la aberración
Se ha mejorado la función de compensación de la aberración.

Principales funciones actualizadas con V1.1
Función de reducción de banda flash
La PMW-400/580 es compatible con la función de reducción de 
banda flash.

Puede activar o desactivar la función de reducción de banda •	
flash en la opción “Reduc. banda flash” del menú OPERAC.
La operación de activación o desactivación de la función de •	
reducción de banda flash puede asignarse al botón asignable 
en la opción “Inter. asig.” del menú OPERAC.
Puede activar o desactivar la indicación de estado de la función •	
de reducción de banda flash en la opción “Reduc. banda flash” 
de “Pantalla On/Off” del menú OPERAC.

Notas
El vídeo y el audio podrían distorsionarse si la función de •	
reducción de banda flash se establece en “On” u “Off”.
Cuando “Obturador” se establece en “On” y la función de •	
reducción de banda flash está establecida en “On”, la función de 
reducción de banda flash se ajusta automáticamente en “Off”.
La función de reducción de banda flash no puede establecerse •	
en “On” cuando la videocámara está en el modo Caché de 
imágenes, el modo de grabación a cámara lenta y rápida, el 
modo de obturador lento o i.LINK.
La función de reducción de banda flash se establece en “Off” •	
cuando la videocámara se reinicia. Ajuste de nuevo la función 
en “On”.

Mensajes y menús en varios idiomas (solo para la PMW-
400)
Los mensajes y los menús están disponibles en español, 
portugués, ruso e indonesio. Asimismo, los mensajes también 
están disponibles en japonés.
“Japanese”, “Spanish”, “Portuguese”, “Russian” e “Indonesian” se han 
añadido en la opción “Language” del menú MANTENIM.
Nota

Los menús aparecen en inglés y los mensajes se muestran en •	
japonés al seleccionar “Japanese”.

Adaptador inalámbrico
La PMW-400/580 es compatible con el adaptador inalámbrico 
opcional CBK-WA101.

Puede establecer “Control grab. SDI” en la opción “Conf. cámara” •	
del menú MANTENIM. en “G.simul” para la grabación 
sincronizada. 
Puede activar o desactivar la función de coincidencia de •	
nombres de clips durante la grabación sincronizada en la 
opción “Coincid. nombre clip” de “Conf. cámara” del menú 
MANTENIM.
Puede activar o desactivar la indicación del estado de la •	
conexión inalámbrica del adaptador inalámbrico en la opción 
“Estado inalámbr.” de “Pantalla On/Off”, en el menú OPERAC.
Puede activar o desactivar la indicación de tiempo restante de •	
una tarjeta SD insertada en el adaptador inalámbrico en la 
opción “Medio ext. restante” de “Pantalla On/Off”, en el menú 
OPERAC.
Puede activar o desactivar la indicación de estado de subida de •	
clip a través del adaptador inalámbrico en la opción “Enviando 
info clip” de “Pantalla On/Off”, en el menú OPERAC.

Notas
Las funciones Wi-Fi del adaptador Wi-Fi CBK-WA01 o el módulo •	
de red LAN inalámbrica USB IFU-WLM3 no están disponibles si 
el adaptador inalámbrico está conectado.
“G.simul” no puede seleccionarse en los modos de grabación •	
especiales. Puede utilizar los siguientes formatos de vídeo con 
“G.simul”. 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

Módulo de red LAN inalámbrica USB
La PMW-400/580 es compatible con el módulo de red LAN 
inalámbrica USB opcional IFU-WLM3, que permite las conexiones 
Wi-Fi.
Notas

En el ajuste de “Escanear redes” de la opción “Conf. Wi-Fi” del •	
menú MANTENIM., solo aparecen “SSID” y “Canal” en la lista 
NETWORK SCAN. Ajuste “Tipo de red” de la opción “Conf. Wi-Fi” 
del menú MANTENIM. de nuevo después de seleccionar la 
conexión.
Si “Tipo de red” está ajustado en “Adhoc”, la opción “Estado Wi-Fi” •	
de “Conf. Wi-Fi”, en el menú MANTENIM., aparece sombreada y 
no se muestra el estado de la conexión.

Formatos de vídeo
La PMW-400/580 es compatible con el formato de grabación 
UDF (MXF) HD420 a 35 Mbps 1920×1080. 

“HD420 HQ1920” se añade a los elementos de “Form. grab.” que •	
pueden seleccionarse en la opción “Formato” del menú OPERAC. 
en el modo UDF/HD/1080.

Función ALAC (corrección de la aberración)
PMW-400/580 es compatible con la función ALAC y puede 
desactivar la función. Asimismo, se muestra el correspondiente 
estado.

Puede activar o desactivar la función ALAC desde “ALAC”, en •	
“Conf. cámara”, en el menú MANTENIM. La función ALAC puede 
utilizarse de forma remota a través del conector REMOTE.
Puede activar o desactivar la indicación de estado de ALAC •	
desde “ALAC”, en “Pantalla On/Off”, en el menú OPERAC. “ALAC” 
aparecerá en la pantalla del visor cuando la indicación de 
estado de ALAC y la función ALAC estén ajustadas en “On” y 
“Auto” respectivamente y el objetivo ALAC compatible corrija la 
aberración.



   

Nota
“ALAC” no aparecerá sin corrección de la aberración aunque se •	
conecte a la videocámara un objetivo ALAC compatible. En este 
caso, calibre el objetivo como corresponda.

中⽂

发⾏通知

V1.7更新的主要功能

新增RECENT FILES状态画⾯
状态画⾯以加载顺序显⽰列表中最近加载的⽂件信息（最多
15个）。
在RECENT FILES状态画⾯中，可以在列表上最多显⽰⽂
件信息的15个⽂件（⽤户⽂件、全⽂件、场景⽂件、参考
⽂件、镜头⽂件每种最多各3个）。
显⽰⽂件加载的⽇期和时间、⽂件类型、媒体类型和⽂件
名。

⽂件⾃定义菜单注册到⽤户菜单
可将⽂件菜单中的以下项⽬注册到⽤户菜单。
• ⽂件菜单 > ⽤户
  > ⽤户加载SxS
  > ⽤户保存SxS
  > ⽤户加载USB
  > ⽤户保存USB
  > ⽂件ID
  > 调出⽤户预设
• ⽂件菜单 > 全⽂件
  > 全加载SxS
  > 全保存SxS
  > 全加载USB
  > 全保存USB
  > 返回全预设值
• ⽂件菜单 > 场景⽂件
  > 调出SxS
  > 保存SxS
  > 调出USB
  > 保存USB
菜单锁定时禁⽤的可指定设定
当锁定菜单时，如果将未注册到⽤户菜单的菜单项⽬指定
到“⾃定义按钮”，则可指定设定禁⽤。
当不想改变除⽤户菜单以外的菜单设定时，此功能很有⽤。

注意

当以下列出的设置菜单的菜单项⽬未注册到⽤户菜单时，
如果锁定菜单，菜单项⽬的功能将⽆法指定到“⾃定义按
钮”。

设置菜单的菜单项⽬
可指定到“⾃定义按钮”
的菜单项⽬

操作 > 特殊拍摄功能 > 
图像缓存拍摄

图像缓存

操作 > 特殊拍摄功能 > 
⽚段连续记录

⽚段连续记录

操作 > VF设定 > 模式 EVF模式

操作 > 显⽰设定 > 亮度 亮度

    
    

    

    
    
    
    

 

 

  
   

 
 

 

 
 

 
 
 

 
 

    
 

 

 
 

 

 

 

  
 
 
 

 
 

 
 

 

 

 
  

  
  

 

 
 

 
 
 

   

 

 

 

 
 

 

 

 

  

 
  

 

 

 

  

 
 

  

 
 

 
 

 
 

     

 
 

 

   

 
 

 

 

 

  

 
 

 

  

 

 

 

 

 

 

  
 

  

 

 
 

 
 

  

   

 
 

 

 

 

 

 

   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   

    

    

    
    

操作 > 显⽰设定 > 直⽅图 直⽅图

操作 > 显⽰设定 > 景深 景深

操作 > TLCS > 模式
Spotlight
Backlight

操作 > TLCS > AGC*
EZ模式

操作 > TLCS > A.SHT*

操作 > 标记 > 设定 标记

维护 > ⾳频 > 前部麦克风
选择

前部麦克风

* 即使“AGC”或“A.SHT”未注册到⽤户菜单，也⽆法
通过“⾃定义按钮”选择“EZ模式”。

改进了SxS媒体的录制时间
改进了SxS媒体录制多个⽚段的最长录制时间。

V1.6更新的主要功能

视频格式
⽀持exFAT模式下的IMX记录。
• exFAT/SD模式下，操作>格式>录制格式中新增了菜单设
定项⽬IMX50。

新增⽤户菜单
新增了⽤户菜单，您可将操作、画质设定或维护菜单下的常
⽤项⽬注册到⽤户菜单。可在⽤户菜单⾃定义菜单中进⾏
注册。

新增锁定菜单功能
新增了锁定设定菜单并只显⽰⽤户菜单的功能。
• 保持按住MENU旋钮并同时按下MENU ON/OFF开关
显⽰设定菜单，在User Menu with Lock>On下输⼊密
码，以锁定菜单显⽰并只显⽰⽤户菜单。
当不想改变除⽤户菜单中的设定以外的菜单设定时，此功
能很有⽤。

• 若要解除锁定并重新显⽰所有菜单列表，保持按住
MENU旋钮并同时按下MENU ON/OFF开关显⽰设定
菜单，然后输⼊锁定菜单时的相同密码。

注意

建议保存好密码以便⽇后使⽤。如果忘记密码，请联系
Sony服务代表。

在2个插槽中同时记录
⽀持使⽤2个SxS插槽进⾏同时记录。
可在操作>特殊拍摄功能>同步录制中打开/关闭此功能。
⽀持以下格式：
• exFAT/HD模式中的以下格式

XAVC-I–
XAVC-L50、L35、L25–
MPEG2 HD422–
MPEG2 HD420HQ–

• UDF/HD模式中的以下格式
MPEG2 HD422–
MPEG2 HD420HQ–

 
 

    
 

 

 
 

 

 

 

  
 
 
 

 
 

 
 

 

 

 
  

  
  

 

 
 

 
 
 

   

 

 

 

 
 

 

 

 

  

 
  

 

 

 

  

 
 

  

 
 

 
 

 
 

     

 
 

 

   

 
 

 

 

 

  

 
 

 

  

 

 

 

 

 

 

  
 

  

 

 
 

 
 

  

   

 
 

 

 

 



   

 

 

   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   

    

    

    
    
    
    

    

    
    
    
    

 

 

  
   

 
 

 

 
 

 
 
 

注意

• 当使⽤同时记录时，请使⽤相同类型和尺⼨的存储卡。
• 同时记录⽆法与以下功能同时使⽤：

逐帧拍摄–
⽚段连续记录–
图像缓存记录–
慢&快动作–
间隔拍摄–

• 同步记录期间不能使⽤IFU-WLM3 USB Wireless 
LAN Module。

⽀持SDXC卡
使⽤选购的MEAD-SD02介质适配器，可记录和播放
SDXC卡。
SDXC卡只能⽤于exFAT模式。
SDXC卡（SD速度级：10）
注意

• 在本机上使⽤SDXC卡时，请使⽤本机的格式化功能将卡
格式化。

• 使⽤SDXC卡可能⽆法正确进⾏⾼速播放。
• 使⽤SDXC卡时，请勿同时使⽤其他类型的存储卡。如果
同时使⽤其他类型的介质，当录制时介质没有空间时，⽆
法切换到其他介质。

• 视使⽤的SDXC卡⽽定，可能⽆法正确执⾏XAVC-I格式
记录或慢&快动作记录。建议使⽤SxS存储卡。

• 视使⽤的装置类型⽽定，⽤PMW和PXW系列摄像机记
录的SDXC卡可能⽆法⽤于在本机上记录和播放。有关详
情，请联系Sony经销商或Sony服务代表。

新增快捷菜单
启⽤快捷菜单后，不通过MENU ON/OFF开关显⽰菜
单，即可改变取景器画⾯中的显⽰项⽬设定。
当维护菜单>快捷菜单设定为On时启⽤快捷菜单。
通过MENU旋钮启⽤快捷菜单设定并直接操作。可操作以
下项⽬。
• ⽩平衡的COLOR TEMP设定
• TLCS的模式设定
• 电⼦快门的快门速度或针对累积帧数的设定
• 慢&快动作模式下的帧频设定

注意

• 如果取景器画⾯中未显⽰快捷菜单的项⽬（操作菜单>显
⽰设定设为Off ），则⽆法通过快捷菜单操作这些项⽬。

• 视项⽬⽽定，以下是启⽤快捷菜单的条件。
⽩平衡的COLOR TEMP设定–
当WHITE BAL（切换⽩平衡存储器）开关置于“A”
或“B”时，以及在菜单中为操作>⽩平衡设定>White
开关<B>>Memory状态下，WHITE BAL开关置
于“B”时
电⼦快门的快门速度设定–
所有模式：
SHUTTER开关设定为ON。
速度模式：
菜单中为操作>快门>快门选择>秒
⾓度模式：
菜单中为操作>快门>快门选择>⾓度
ECS模式：
设定了ECS模式。
电⼦快门的累积帧数设定–
低速快门模式：菜单中为操作>快门>低速快门>On

 
  

  
  

 

 
 

 
 
 

   

 

 

 

 
 

 

 

 

  

 
  

 

 

 

  

 
 

  

 
 

 
 

 
 

     

 
 

 

   

 
 

 

 

 

  

 
 

 

  

 

 

 

 

 

 

  
 

  

 

 
 

 
 

  

   

 
 

 

 

 

 

 

   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   

    

    

    
    
    
    

    

    
    
    
    

 

 

  
   

 
 

 

 
 

 
 
 

 
 

    
 

 

 
 

 

 

 

  
 
 
 

 
 

 
 

 

 

慢&快动作模式下的帧频设定–
菜单中为操作>特殊拍摄功能>慢&快动作>On

部分传输本机上记录的原始⽂件
可以通过在本机记录的原始⽂件中指定输⼊和输出点，传输
⽂件的剪切部分。
还可以使⽤故事板传输多个⽂件的剪切部分。
部分传送功能需要使⽤以下设备和应⽤程序。
• 在本摄像机上安装⽆线适配器CBK-WA101（选购）。
• 在通过Wireless LAN与本摄像机连接的设备上使⽤

Content Browser Mobile应⽤程序。（使⽤最新版本
的“Content Browser Mobile”应⽤程序。）

⽀持以下原⽂件：
• exFAT/HD模式中的以下⽂件

XAVC-I–
XAVC-L50、L35、L25–
MPEG2 HD422–
MPEG2 HD420HQ–

• UDF/HD模式中的以下⽂件
MPEG2 HD422–
MPEG2 HD420HQ–

注意

• 若要使⽤“Content Browser Mobile”传送部分原⽂
件，使⽤以下设定记录与原⽂件名称相同的代理⽂件。
维护菜单>摄像机设置>SDI录制控制>同时录制–
维护菜单>摄像机设置>匹配⽚段名称>On–

• 正在传送部分原⽂件时，⽆法进⾏以下操作。
⽚段操作–
格式化媒体–
通过USB连接PC–

• 传送部分原⽂件时，将图像存储到图像缓存记录的图像缓
存中的时间，⽐在操作菜单>特殊拍摄功能>图像缓存拍摄
时间中所设定的时间短。

新增Wi-Fi遥控器设定的状态显⽰
在可指定开关/遥控状态画⾯中新增了维护菜单下Wi-Fi设
定>Wi-Fi遥控的设定显⽰。

Wi-Fi菜单
通过⽆线适配器CBK-WA101（选购）连接时，可在维护
菜单下设定Wi-Fi设定>Wi-Fi和Wi-Fi设定>Wi-Fi遥控。

新增画⾯显⽰
当连接⽆线适配器CBK-WA101（选购）时，可在取景器
画⾯上显⽰以下状态。
• 显⽰与⽆线适配器CBK-WA101（选购）的有线LAN连
接的状态。

• 显⽰⽹络客户端模式的连接状态。
• 显⽰串流状态。

V1.5更新的主要功能

视频格式
PMW-400/580兼容exFAT模式下的MPEG2录制格式。
• 在exFAT模式下，现在可以从操作菜单“格式”的
“HD/SD切换”中选择SD。

• 在exFAT/HD/720模式下，操作菜单“格式”中的
“系统频率”可选项⽬新增了“29.97P”、“23.98P”
和“25P”。

• 在exFAT模式下，操作菜单“格式”中的“录制格式”可
选项⽬新增了“HD422”、“HQ”和“DVCAM”。

  

 
  

 

 

 

  

 
 

  

 
 

 
 

 
 

     

 
 

 

   

 
 

 

 

 

  

 
 

 

  

 

 

 

 

 

 

  
 

  

 

 
 

 
 

  

   

 
 

 

 

 



   

 

 

   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   

    

    

    
    
    
    

    

    
    
    
    

 

 

  
   

 
 

 

 
 

 
 
 

 
 

    
 

 

 
 

 

 

 

  
 
 
 

 
 

 
 

 

 

 
  

  
  

 

 
 

 
 
 

   

 

 

 

 
 

 

 

 

V1.4更新的主要功能

视频格式
PMW-400/580兼容XAVC Long GOP（XAVC-L）格
式。
• 在exFAT模式下，操作菜单的“格式”中“录制格式”
的可选项⽬新增了“XAVC-L 50”、“XAVC-L 35”
和“XAVC-L 25”。

PMW-400/580兼容CBK-CE01的版本显⽰。
• 维护菜单的“版本”中新增了“CBK-CE01”。

V1.3更新的主要功能

视频格式
PMW-400/580兼容XAVC帧内（XAVC-I）格式。
• 操作菜单“格式”的“⽂件系统”中新增了可选
项⽬“exFAT”。当选择“exFAT”时，⾃动设
定“XAVC-I”。

V1.22更新的主要功能

功能现已改善。
• 当连接HXCU-FB70时，即启⽤HXCU-FB70 

PRESET（⽩平衡预设）按钮。
• 维护菜单->强制同步>参考信号中有显⽰CA。
• 经改善，当区域设定为PAL时，NDF不会出现在单⾊

LCD⾯板的状态显⽰中。
• 当在UDF模式中录制格式被设定为HD420 HQ1920
时，取景器屏幕中的视频格式显⽰已被改善。

V1.2更新的主要功能

USB媒体连接功能
通过连接到OPTION接⼝，⽀持对使⽤USB接⼝的外部存
储媒体（如硬盘或闪存驱动器）上的⽚段进⾏复制和播放。 
• USB设定已添加到维护菜单。可以使⽤此菜单项操作USB
媒体。

• 可将SxS存储卡上存储的⽚段复制和备份到外部存储媒
体。 

• 然后可以将外部存储媒体上的⽚段复制到SxS存储卡。
• 此时即可直接播放外部存储媒体上的⽚段。

注意

• ⽀持使⽤5.0 V / 0.5 A电源的外部存储媒体。本机可能不
会识别其他存储设备。在此情况下，请为存储设备单独使
⽤电源。 

• 不保证所有媒体均⽀持此操作。关于验证本机中使⽤的媒
体，请咨询购买录像机的经销店。

• 使⽤USB媒体前，请使⽤摄像机菜单上的格式化USB将其
格式化。

摄像机适配器
安装摄像机适配器后，现已⽀持内部⾯板的切换操作。
• 维护 >摄像机设置 >CCU操作菜单选项可让您将主机切换
操作设为标准或本地（⽐如禁⽤或启⽤）。

注意

• 如果更改主机切换操作设置，本机将会⾃动重启。
• 启⽤主机切换操作时，CCU遥控器显⽰、返回视频和指
⽰灯显⽰，以及来⾃CCU的调⽤操作均会启⽤，但会禁
⽌通过CCU或REMOTE接⼝进⾏远程控制。

⾊差补偿功能
⾊差补偿功能已改善。

 

 

 

  

 
 

 

  

 

 

 

 

 

 

  
 

  

 

 
 

 
 

  

   

 
 

 

 

 

 

 

   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   

    

    

    
    
    
    

    

    
    
    
    

 

 

  
   

 
 

 

 
 

 
 
 

 
 

    
 

 

 
 

 

 

 

  
 
 
 

 
 

 
 

 

 

 
  

  
  

 

 
 

 
 
 

   

 

 

 

 
 

 

 

 

  

 
  

 

 

 

  

 
 

  

 
 

 
 

 
 

     

 
 

 

   

 
 

V1.1更新的主要功能

闪光带减弱功能
PMW-400/580具有闪光带减弱功能。
• 可以在操作菜单的“闪光带减弱”中打开/关闭闪光带减弱
功能。

• 可以在操作菜单的“⾃定义按钮”中将闪光带减弱打开/关
闭操作指定到可指定按钮。

• 可以在操作菜单的“显⽰设定”中通过“闪光带减弱”将
闪光带减弱状态指⽰设定为打开/关闭。

注意

• 当闪光带减弱功能设定为“On”或“Off ”时，视频和⾳
频可能会失真。

• 当闪光带减弱功能设定为“On”时，如果将“快门”设
定为“On”，闪光带减弱功能将⾃动改变为“Off ”。

• 当本机处于图像缓冲模式、S&Q录制模式、低速快门模
式或正在输出i.LINK时，⽆法将闪光带减弱功能设定
为“On”。

• 当本机重新启动时，闪光带减弱功能将设定为“Off ”。
请将此功能重新设定为“On”。

多语⾔菜单和信息（仅PMW-400）
可提供西班⽛语、葡萄⽛语、俄语和印尼语菜单和信息。同
时提供⽇语信息。
在维护菜单的“Language”中增加了“Japanese”、
“Spanish”、“Portuguese”、“Russian”
和“Indonesian”。

注意

• 选择“Japanese”时，菜单将以英语显⽰，信息则以⽇语
显⽰。

⽆线适配器
PMW-400/580兼容选购的CBK-WA101⽆线适配器。
• 可以在维护菜单的“摄像机设置”中将“SDI录制控制”
设定为“同时录制”以允许同步录制。

• 可以在维护菜单的“摄像机设置”中的“匹配⽚段名称”
中打开/关闭同步录制期间的匹配⽚段名称功能。

• 可以在操作菜单的“显⽰设定”中的“⽆线状态”下打开/
关闭⽆线适配器的⽆线状态指⽰。

• 可以在操作菜单的“显⽰设定”中的“外部存储卡余量”
下打开/关闭⽆线适配器中插⼊的SD卡的剩余时间指⽰。

• 可以在操作菜单的“显⽰设定”中的“正在传送⽚段信
息”下打开/关闭通过⽆线适配器上传⽚段的状态指⽰。

注意

• 连接⽆线适配器时，CBK-WA01 Wi-Fi适配器或IFU-
WLM3 USB⽆线局域⽹模块的Wi-Fi功能不可⽤。

• ⽆法在特定录制模式下设定“同时录制”。 可以使⽤以下
视频格式进⾏“同时录制”。
1920×1080/59.94i、50i、29.97P、25P、23.98P
1440×1080/59.94i、50i、29.97P、25P、23.98P
1280×720/59.94P、50P

USB⽆线局域⽹模块
PMW-400/580兼容可进⾏Wi-Fi连接的选购IFU-WLM3 
USB⽆线局域⽹模块。

 
 

 
 

  

   

 
 

 

 

 



   

 

 

   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   
   

    

    

    
    
    
    

    

    
    
    
    

 

 

  
   

 
 

 

 
 

 
 
 

 
 

    
 

 

 
 

 

 

 

  
 
 
 

 
 

 
 

 

 

 
  

  
  

 

 
 

 
 
 

   

 

 

 

 
 

 

 

 

  

 
  

 

 

 

  

 
 

  

 
 

 
 

 
 

     

 
 

 

   

 
 

 

 

 

  

 
 

 

  

 

 

 

 

 

 

  
 

  

 

注意

• 对于维护菜单“Wi-Fi设定”中的“扫描⽹络”设
定，NETWORK SCAN列表中只显⽰“SSID”
和“Ch”。 选择连接后重新设定维护菜单“Wi-Fi设
定”中的“Network Type”。

• 当“Network Type”设定为“Adhoc”时，维护菜
单“Wi-Fi设定”中的“Wi-Fi状态”呈灰⾊，且不显⽰
连接状态。

视频格式
PMW-400/580兼容UDF（MXF）HD420 35 Mbps 
1920×1080的录制格式。
• 在UDF/HD/1080模式下，在操作菜单的“格式”中的
“录制格式”中增加了“HD420 HQ1920”可选项⽬。

ALAC（⾊差修正）功能
PMW-400/580具有ALAC功能，并且可以关闭此功能。
另外，状态也会相应显⽰。
• 可以在维护菜单的“摄像机设置”中通过“ALAC”打
开/关闭ALAC功能。可以通过REMOTE接⼝远程操作
ALAC功能。

• 可以在操作菜单的“显⽰设定”中通过“ALAC”打开/
关闭ALAC状态指⽰。当ALAC状态指⽰和ALAC功能分
别设定为“On”和“⾃动”并且ALAC兼容镜头对⾊差
进⾏了修正时，取景器屏幕上会显⽰“ALAC”。

注意

• 即使本机上安装了ALAC兼容镜头，⽆⾊差修正时也不显
⽰“ALAC”。此时，请相应校准镜头。

Русский

Примечание к версии
Основные функции, обновленные в версии 1.7
Добавление экрана состояния RECENT FILES
На экране состояния отображается список с информацией о 
последних загруженных файлах (до 15) в порядке загрузки.
На экран состояния RECENT FILES можно вывести список до 
15 файлов с информацией (по 3 файла Пользователь, Все, 
Сцена, Ссылка или Объектив).
Отображаются дата и время загрузки файла, тип файла, тип 
носителя и имя файла.

Регистрация меню настройки файла в меню 
ПОЛЬЗОВАТЕЛЬ
Указанные ниже элементы меню ФАЙЛ можно 
зарегистрировать в меню ПОЛЬЗОВАТЕЛЬ.

ФАЙЛ > Пользователь•	
  > Польз. загр. SxS
  > Польз. сохр. SxS
  > Польз. загр. USB
  > Польз. сохр. USB
  > Файл ID
  > Отзыв польз. предуст.

ФАЙЛ > Все•	  > Все загр.SxS
  > Все сохр. SxS
  > Все загруз. USB
  > Все сохран. USB
  > Все предустан.

ФАЙЛ > Сцена•	  > Вызов сцены SxS
  > Сохранение сцены SxS
  > Вызов сцены USB
  > Сохранение сцены USB

Отключение назначаемой настройки во время 
блокировки меню
Если элемент меню, который не зарегистрирован в меню 
ПОЛЬЗОВАТЕЛЬ, присвоен для “Назн.Перекл.”, когда меню 
заблокировано, назначаемая настройка будет отключена.
Эта функция полезна, когда не требуется изменять настройку 
меню, кроме меню ПОЛЬЗОВАТЕЛЬ.
Примечание

Если меню заблокировано, когда указанные ниже элементы 
меню настройки не зарегистрированы в меню 
ПОЛЬЗОВАТЕЛЬ, функцию элемента меню невозможно 
присвоить для “Назн.Перекл.”.

Элементы меню 
настройки

Элементы меню, 
которые можно 
присвоить для “Назн.
Перекл.”

РАБ. > Функ.зап. > Зап. кэша 
изобр. Кэш изобр.

РАБ. > Функ.зап. > Непр. зап. 
клипа Непр. зап. клипа

РАБ. > Настр. в/иск. > Реж. Реж. в/иск.

РАБ. > Диспл. Вкл/Выкл > 
яркость дисплея яркость дисплея

РАБ. > Диспл. Вкл/Выкл > 
Отобр. гистогр. Гистогр.

РАБ. > Диспл. Вкл/Выкл > 
Инф. об объект. Инф. об объект.

РАБ. > TLCS > Реж.
Местн. осв.

Задн. подсв.

РАБ. > TLCS > AGC*
Реж. EZ

РАБ. > TLCS > Авто затвор*

РАБ. > Маркер > Устан. Маркер

ОБСЛУЖ. > Аудио > Выб.
пер.мик. Передн. микр.

Даже если параметр “AGC” или “Авто затвор” не * 
зарегистрирован в меню ПОЛЬЗОВАТЕЛЬ, “Реж. EZ” 
невозможно выбрать с помощью “Назн.Перекл.”.

Улучшено время записи для носителя SxS
Улучшено максимальное время записи для носителя SxS при 
записи нескольких клипов.

Основные функции, обновленные в версии 
1.6
Видеоформат
Запись IMX поддерживается в режиме exFAT.



   

Пункт IMX50 добавлен в настройки меню для •	
РАБ.>Формат>Формат зап. в режиме exFAT/SD.

Добавление меню “Пользователь”
Добавлено новое меню “Пользователь”, и теперь часто 
используемые элементы можно зарегистрировать в меню 
РАБ., PAINT или ОБСЛУЖ. для меню “Пользователь”. 
Регистрацию можно выполнить в меню НАСТР. МЕНЮ ПОЛЬЗ.

Добавление функции блокировки меню
Добавлена функция для блокировки меню настройки, чтобы 
отображалось только меню “Пользователь”.

Нажав и удерживая кнопку MENU, одновременно нажмите •	
переключатель MENU ON/OFF, чтобы отобразить меню 
настройки, и введите пароль в User Menu with Lock>Вкл для 
блокировки отображения меню и отображения только меню 
“Пользователь”. 
Эта функция удобна в том случае, если не требуется 
изменять настройки меню, кроме пунктов в меню 
“Пользователь”.
Чтобы отключить блокировку и снова отобразить все списки •	
меню, нажав и удерживая кнопку MENU, одновременно 
нажмите переключатель MENU ON/OFF, чтобы отобразить 
меню настройки, затем введите тот же пароль, который был 
введен при блокировке меню.

Примечание

Пароль рекомендуется сохранить для использования в 
дальнейшем. Если вы забыли пароль, обратитесь к 
представителю службы по работе с клиентами Sony.

Одновременная запись в 2 гнездах
Поддерживается одновременная запись с использованием 2 
гнезд SxS.
Функции можно включить/выключить в меню РАБ.>Функ.
зап.>Одновремен. Запись.
Поддерживаются следующие форматы:

Следующие форматы в режиме exFAT/HD•	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Следующие форматы в режиме UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Примечания
При использовании одновременной записи используйте •	
карты памяти одного типа и размера.
Одновременную запись не удастся использовать вместе со •	
следующими функциями:

запись кадров;–
непрерывная запись клипов;–
запись в режим кэша изображений;–
при замедленном/ускоренном воспроизведении;–
запись с интервалом.–

Модуль IFU-WLM3 USB Wireless LAN Module не может •	
использоваться во время одновременной записи.

Поддержка карты SDXC
При использовании дополнительного адаптера MEAD-SD02 
можно выполнять запись на карту SDXC и воспроизведение с 
нее.
Карту SDXC не удастся использовать в режиме exFAT.
Карта SDXC (класс скорости SD: 10)

Примечания
Для использования карты SDXC с этим устройством ее •	
необходимо отформатировать с помощью функции 
форматирования этого устройства.
Возможно, не удастся достичь надлежащего •	
высокоскоростного воспроизведения при использовании 
карты SDXC.
При использовании карты SDXC не используйте •	
одновременно с ней карты памяти других типов. При 
одновременном использовании других типов носителей не 
удастся выполнить переключение на другой носитель, когда 
на этом носителе будет занято все место при записи.
Возможно, не удастся правильно выполнить запись в •	
формате XAVC-I или запись с функцией замедленного/
ускоренного воспроизведения в зависимости от 
используемой карты SDXC. Рекомендуется использовать 
карту памяти SxS.
Карту SDXC, записанную с помощью видеокамеры серии •	
PMW и PXW, возможно, не удастся использовать для записи 
и воспроизведения с определенными типами этого 
устройства. Для получения дополнительной информации 
обратитесь к дилеру Sony или представителю службы по 
работе с клиентами Sony.

Добавление меню “Прям.”
При включении меню “Прям.” настройки можно изменять с 
помощью элементов, отображаемых в видоискателе, при этом 
не требуется отображать меню с помощью переключателя 
MENU ON/OFF.
Меню “Прям.” включается при выборе меню ОБСЛУЖ. и 
установке для параметра Меню “Прям.” значения “Вкл”.
С помощью кнопки MENU можно включить настройку меню 
“Прям.” и управлять им напрямую. Можно управлять 
следующими пунктами меню.

Настройки COLOR TEMP баланса белого•	
Настройки режима для TLCS•	
Скорость электронного затвора или настройки для числа •	
снятых кадров
Настройка частоты кадров в режиме замедленного/•	
ускоренного воспроизведения

Примечания
Если пункты меню “Прям.” не отображаются на экране •	
видоискателя (выбор меню РАБ., установка для параметра 
“Диспл. Вкл/Выкл” значения “Выкл”), то вам не удастся 
управлять этими пунктами с помощью меню “Прям.”.
Далее указаны условия открытия меню “Прям.” в зависимости •	
от элементов.

Настройка COLOR TEMP баланса белого –
Для переключателя WHITE BAL (переключение памяти 
баланса белого) установлено положение “A” или “B”, а для 
переключателя WHITE BAL установлено положение “B” в 
меню РАБ.>Настр.бал.бел.>Перекл. бал. бел.<B>>Память
Настройка скорости электронного затвора –
Все режимы: 
для переключателя SHUTTER установлено положение ON. 
Режим скорости: 
РАБ.>Затвор>Выбор затвора>Секунда в меню 
Режим угла: 
РАБ.>Затвор>Выбор затвора>Градус в меню 
Режим ECS: 
установлен режим ECS.
Настройка числа снятых кадров электронного затвора –
Режим Медл. затвор: РАБ.>Затвор>Медл. затвор>Вкл в 
меню



   

Настройка частоты кадров в режиме замедленного/–
ускоренного воспроизведения 
РАБ.>Функ.зап.>Замедл./уск.движ.>Вкл в меню

Частичная передача исходного файла, записанного на 
это устройство
Можно передавать часть файла, указав точки In и Out в 
исходном файле, записанном этим устройством. 
Также можно передавать части нескольких файлов с помощью 
Storyboard.
Для частичной передачи необходимы следующее устройство 
и приложение.

Подключите беспроводной адаптер CBK-WA101 •	
(приобретается дополнительно) к этой видеокамере.
Используйте приложение Content Browser Mobile на •	
устройстве, которое подключено через сеть Wireless LAN к 
этой видеокамере. (Используйте последнюю версию 
приложения “Content Browser Mobile”.)

Поддерживаются следующие типы исходных файлов:
Следующие файлы в режиме exFAT/HD•	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Следующие файлы в режиме UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Примечания
Чтобы выполнить частичную передачу исходного файла с •	
помощью приложения “Content Browser Mobile”, создайте 
прокси-файл с таким же именем, что и у оригинального 
файла, используя следующие настройки.

меню ОБСЛУЖ.>Настр. кам.>Управл. запис. SDI>Одновр.–
зап.
меню ОБСЛУЖ.>Настр. кам.>Сопост.назв. клипа>Вкл–

При частичном переносе исходного файла не удастся •	
выполнить следующие операции.

Действия с клипом–
Форматирование карты памяти–
Подключение ПК с помощью USB–

При частичной передаче исходного файла сохранение •	
изображений в кэш-память изображений занимает меньше 
времени, чем задано в меню РАБ.>Функ.зап.>Вр.зап.кэша 
изоб.

Добавление отображения состояния настроек пульта 
дистанционного управления Wi-Fi
На экран состояния назначаемых переключателей/
удаленного доступа добавлено отображение настроек 
Настройка Wi-Fi>Отд.дост.Wi-Fi в меню ОБСЛУЖ.

Меню Wi-Fi 
При подключении через беспроводной адаптер CBK-WA101 
(приобретается дополнительно) можно настроить пункты 
Настройка Wi-Fi>Wi-Fi и Настройка Wi-Fi>Отд.дост.Wi-Fi в меню 
ОБСЛУЖ.

Добавление экранной индикации
Следующее состояние может отображаться на экране 
видоискателя при подключении беспроводного адаптера 
CBK-WA101 (приобретается дополнительно).

Отображение состояния проводного подключения LAN на •	
экране состояния беспроводного адаптера CBK-WA101 
(приобретается дополнительно).
Отображение состояния подключения в режиме сетевого •	
клиента.

Отображение состояния потоковой передачи.•	

Основные функции, обновленные в версии 
1.5
Видеоформаты
PMW-400/580 совместима с форматом записи MPEG2 в 
режиме exFAT.

SD теперь можно выбрать в “HD/SD” в пункте “Формат” меню •	
РАБ. в режиме exFAT.
“29.97P”, “23.98P” и “25P” добавляется к выбираемым •	
элементам “Сист. част.” в пункте “Формат” меню РАБ. в режиме 
exFAT/HD/720.
“HD422”, “HQ” и “DVCAM” добавляется к выбираемым •	
элементам “Формат зап.” в пункте “Формат” меню РАБ. в 
режиме exFAT.

Основные функции, обновленные в версии 
1.4
Видеоформаты
Модель PMW-400/580 поддерживает формат кодека XAVC 
Long GOP (XAVC-L).

Добавлены значения “XAVC-L 50”, “XAVC-L 35” и “XAVC-L 25” для •	
некоторых элементов параметра “Формат записи” в меню 
“Формат” раздела РАБОТА в режиме exFAT.

Модель PMW-400/580 поддерживает версию дисплея 
устройства CBK-CE01.

Элемент “CBK-CE01” добавлен в список параметров “Версия” в •	
меню ОБСЛУЖИВАНИЕ.

Основные функции, обновленные в версии 
1.3
Видеоформаты
Модель PMW-400/580 поддерживает формат внутрикадрового 
режима XAVC (XAVC-I).

“exFAT” добавляется для выбираемых файлов в области “Файл.•	
сист.” раздела “Формат” меню РАБ. Если выбран параметр 
“exFAT”, “XAVC-I” устанавливается автоматически.

Основные функции, обновленные в версии 
1.22
Сейчас улучшены функции.

Включена поддержка кнопки PRESET (предустановка баланса •	
белого) устройства HXCU-FB70 при подключенном HXCU-
FB70.
CA теперь отображается в меню ОБСЛУЖ.>Внешняя •	
синхр.>Ссылка.
Были сделаны улучшения, чтобы NDF не появлялся в окне •	
состояния монохромной ЖК-панели, при выбранном 
значении PAL для параметра Страна.
Были сделаны улучшения отображения формата видео на •	
экране видоискателя, когда для параметра Формат зап. 
установлено значение HD420 HQ1920 в режиме UDF.

Основные функции, обновленные в версии 
1.2
Функция подключения USB-носителей
Клипы, сохраненные на внешнем накопителе с интерфейсом 
USB, например на жестком диске или флэш-накопителе, 
можно копировать и воспроизводить. Для этого накопитель 
необходимо подключить к разъему OPTION.

В меню ОБСЛУЖ. добавлен пункт Установка USB. Он •	
позволяет управлять USB-носителями.



   

Теперь клипы, сохраненные на картах памяти SxS, можно •	
копировать на внешние накопители. Кроме того, на внешних 
накопителях можно создавать резервные копии этих клипов.
Теперь клипы, сохраненные на внешних накопителях, можно •	
копировать на карты памяти SxS.
Теперь клипы, сохраненные на внешних накопителях, можно •	
воспроизводить непосредственно с них.

Примечания
Поддерживаются внешние накопители с питанием от •	
источников на 5,0 В и 0,5 А. Возможно, устройство не сможет 
распознать другие накопители. В таких случаях для 
накопителя необходимо обеспечить отдельный источник 
питания.
Работа всех носителей не гарантируется. Узнать о том, какие •	
носители подходят для этого устройства, можно в магазине, 
в котором была приобретена видеокамера.
Перед использованием USB-носителя его необходимо •	
отформатировать, выбрав пункт Форматировать USB в меню 
видеокамеры.

Переходник видеокамеры
Теперь можно выполнять переключения для внутренней 
панели, когда установлен переходник видеокамеры.

Последовательно выбрав в меню ОБСЛУЖ. > Настр. кам. > •	
Работа CCU, можно настроить режим переключения 
основного устройства — Норм. или Местный (т. е. включить 
или выключить функцию переключения).

Примечания
При изменении настройки переключения основного •	
устройства оно автоматически перезапустится.
Когда включена функция переключения основного •	
устройства, работают функции выведения изображения на 
удаленный контроллер CCU и отображения обратного 
видеосигнала, а также возможно осуществление световой 
индикации и вызовов с CCU. Однако при этом 
дистанционное управление через CCU или разъем REMOTE 
не работает.

Функция коррекции аберрации
Функция коррекции аберрации усовершенствована.

Основные функции, обновленные в версии 
1.1
Функция подавления полос вспышки
Модель PMW-400/580 совместима с функцией подавления 
полос вспышки.

Функцию подавления полос вспышки можно включить/•	
выключить в настройках параметра “Корр. “вспышек”” меню 
РАБ.
Действие включения/выключения функции подавления •	
полос вспышки можно назначить кнопке с возможностью 
назначения в настройках параметра “Назн.Перекл.” меню РАБ.
Обозначение состояния функции подавления полос •	
вспышки можно включить/выключить в настройках 
параметра “Корр. “вспышек”” в р азделе “Диспл. Вкл/Выкл” 
меню РАБ.

Примечания
Если для функции подавления полос вспышки выбрано •	
значение “Вкл” или “Выкл”, при записи видео и аудио могут 
появиться искажения.
Если для параметра “Затвор” выбрано значение “Вкл”, когда •	
для функции подавления полос вспышки установлено 
значение “Вкл”, для функции подавления полос вспышки 
автоматически будет установлено значение “Выкл”.

Не удастся установить для функции подавления полос •	
вспышки значение “Вкл”, если видеокамера используется в 
режиме кэша изображений, режиме записи S&Q, режиме 
медленного затвора или в режиме вывода сигнала i.LINK.
При перезапуске видеокамеры для функции подавления •	
полос вспышки устанавливается значение “Выкл”. В этом 
случае необходимо снова установить для функции значение 
“Вкл”.

Меню и сообщения на нескольких языках (только для 
модели PMW-400)
Доступны меню и сообщения на испанском, португальском, 
русском и индонезийском языках. Кроме того, доступны 
сообщения на японском языке.
В раздел “Language” меню ОБСЛУЖ. добавлены пункты 
“Japanese”, “Spanish”, “Portuguese”, “Russian” и “Indonesian”.
Примечание

При выборе значения “Japanese” меню будут отображаться на •	
английском языке, а сообщения — на японском.

Адаптер беспроводной сети
Модель PMW-400/580 совместима с адаптером беспроводной 
сети CBK-WA101 (приобретается дополнительно).

Чтобы включить синхронизированную запись, установите •	
для параметра “Управл. запис. SDI” в разделе “Настр. кам.” 
меню ОБСЛУЖ. значение “Одновр.зап.”. 
Можно включить/выключить функцию сопоставления •	
названия клипа при выполнении синхронизированной 
записи в настройках параметра “Сопост.назв. клипа” в 
разделе “Настр. кам.” меню ОБСЛУЖ.
Обозначение состояния беспроводной сети можно •	
включить/выключить в настройках параметра 
“Беспроводной статус” в разделе “Диспл. Вкл/Выкл” меню РАБ.
Обозначение оставшегося времени для карты памяти SD, •	
вставленной в гнездо адаптера беспроводной сети, можно 
включить/выключить в настройках параметра “Оставш. емк. 
внешн.нос.” в разделе “Диспл. Вкл/Выкл” меню РАБ.
Обозначение состояния выгрузки клипа через адаптер •	
беспроводной сети можно включить/выключить в 
настройках параметра “Инф. об отправл. клипе” в разделе 
“Диспл. Вкл/Выкл” меню РАБ.

Примечания
Функции Wi-Fi-соединения Wi-Fi-адаптера CBK-WA01 или •	
USB-модуля беспроводной локальной сети IFU-WLM3 будут 
недоступны, когда подсоединен адаптер беспроводной сети.
В определенных режимах записи параметр “Одновр.зап.” •	
задать нельзя. Для параметра “Одновр.зап.” можно 
использовать следующие форматы записи. 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

USB-модуль беспроводной локальной сети
Модель PMW-400/580 совместима с USB-модулем 
беспроводной локальной сети IFU-WLM3 (приобретается 
дополнительно), который позволяет установить Wi-Fi-
соединение.
Примечания

В списке NETWORK SCAN для параметра “Сканирование сети” •	
в разделе “Настройка Wi-Fi” меню ОБСЛУЖ. отображаются 
только значения “SSID” и “Ch”. Выбрав соединение, заново 
задайте параметр “Тип сети” в разделе “Настройка Wi-Fi” меню 
ОБСЛУЖ.



   

Если для параметра “Тип сети” выбрано значение “Adhoc”, то •	
параметр “Сост. Wi-Fi” в разделе “Настройка Wi-Fi” меню 
ОБСЛУЖ. будет затенен серым, а состояние соединения не 
будет отображаться.

Видеоформаты
Модель PMW-400/580 поддерживает форматы записи в 
режиме UDF (MXF) HD420 35 Мбит/с, 1920×1080.

В список доступных для выбора элементов параметра •	
“Формат зап.” в разделе “Формат” меню РАБ. добавлен пункт 
“HD420 HQ1920” в режиме UDF/HD/1080.

Функция ALAC (коррекция аберрации)
PMW-400/580 поддерживает функцию ALAC и может 
выключить эту функцию. Кроме того, отображается 
соответствующее состояние.

Функцию ALAC можно включить/выключить на экране “ALAC” •	
в пункте “Настр. кам.” меню ОБСЛУЖ. Функцией ALAC можно 
управлять дистанционно с помощью разъема REMOTE.
Индикацию состояния ALAC можно включить/выключить на •	
экране “ALAC” в пункте “Диспл. Вкл/Выкл” меню РАБ. На 
экране видоискателя появится индикация “ALAC”, когда для 
индикации состояния ALAC или функции ALAC установлено 
значение “Вкл” и “Авто” соответственно, и выполняется 
коррекция аберрации с помощью объектива, 
поддерживающего функцию ALAC.

Примечание
Индикация “ALAC” не отображается без выполнения •	
коррекции аберрации, даже если к видеокамере 
подсоединен объектив с поддержкой функции ALAC. В этом 
случае выполните соответствующую калибровку объектива.

Português

Nota de lançamento
Principais funções atualizadas para a V1.7
Adição da tela de status RECENT FILES
A tela de status exibe informações de arquivos (até 15) que foram 
recentemente carregados na lista na ordem carregada.
Na tela de status RECENT FILES, é possível exibir na lista até 15 
arquivos de informação de arquivos (até 3 para cada arquivo 
Usuário, arquivo Todos, arquivo Cena, arquivo Ref. ou arquivo 
Lente).
São exibidos a data e hora em que o arquivo foi carregado, tipo 
de arquivo, tipo de mídia e nome de arquivo.

Registro do menu de personalização de arquivo no menu 
USUÁRIO
Os seguintes itens no menu ARQUIVO podem ser registrados no 
menu USUÁRIO.

ARQUIVO > Usuário•	
  > Car usuário SxS
  > Salvar usuário SxS
  > Car usuário USB
  > Salvar usuário USB
  > ID do Arquivo
  > Recup pré-defin usuário

ARQUIVO > Todos•	
  > Chamar Todos SxS
  > Salvar Todos SxS
  > Chamar Todos USB
  > Salvar Todos USB
  > Todos Predefin.

ARQUIVO > Cena•	
  > Chamar Cena SxS
  > Armazenar Cena SxS
  > Chamar Cena USB
  > Armazenar Cena USB

Configuração atribuível desativada quando o menu está 
bloqueado
Se um item de menu que não está registrado no menu USUÁRIO 
estiver atribuído a “Alt. Atribuív.” quando o menu estiver 
bloqueado, a configuração atribuível estará desativada.
Essa função é útil quando você não quer alterar uma 
configuração de menu que não seja o menu USUÁRIO.
Nota

Se o menu estiver bloqueado quando os itens do menu de 
configuração listados abaixo não estiverem registrados no menu 
USUÁRIO, a função do item de menu não poderá ser atribuída a 
“Alt. Atribuív.”.

Itens do menu de 
configuração

Itens de menu que podem 
ser atribuídos a “Alt. 
Atribuív.”

OPERAÇÃO > Função Grav. > 
Grav Imag. Cache Cache Imag.

OPERAÇÃO > Função Grav. > 
Grav Contínua Clipe Grav Contínua Clipe

OPERAÇÃO > Config. Visor > 
Modo Modo Visor

OPERAÇÃO > Pain. Lig/Desl > 
Exibição do Brilho Exibição do Brilho

OPERAÇÃO > Pain. Lig/Desl > 
Exibição Histograma Histograma

OPERAÇÃO > Pain. Lig/Desl > 
Info Lente Info Lente

OPERAÇÃO > TLCS > Modo
Holofote

Luz Fundo

OPERAÇÃO > TLCS > AGC*

Modo EZOPERAÇÃO > TLCS > 
Obturador Auto*

OPERAÇÃO > Marcador > 
Config. Marcador

MANUTENÇÃO > Áudio > Sel. 
MIC Frontal Mic Frontal

Mesmo se “AGC” ou “Obturador Auto” não estiver registrado no * 
menu USUÁRIO, “Modo EZ” não poderá ser selecionado por “Alt. 
Atribuív.”.

O tempo de gravação de uma mídia SxS foi melhorado
O tempo máximo de gravação de uma mídia SxS para vários 
clipes de gravação foi melhorado.



   

Principais funções atualizadas para a V1.6
Formato de vídeo
Gravação IMX é suportada no modo exFAT.

IMX50 foi adicionado ao item do menu de ajuste para •	
OPERAÇÃO>Formatar>Form. Grav no modo exFAT/SD.

Adicionar ao menu Usuário 
O menu Usuário foi recentemente adicionado é você pode 
registrar os itens usados com mais frequência sob os menus 
OPERAÇÃO, PAINT, ou MANUTENÇÃO no menu Usuário. O 
registro pode ser feito no menu PERSONALIZAR MENU DO 
USUÁRIO.

Adicionando a função de bloqueio do menu
Foi adicionada uma função para bloquear o menu de 
configuração e somente exibir o menu Usuário.

Mantenha pressionado o botão MENU e pressione a chave •	
MENU ON/OFF ao mesmo tempo para exibir o menu de 
Configuração e inserir a senha no User Menu with Lock>Lig. 
para bloquear a exibição de menus e exibir apenas o menu 
Usuário. 
Esta função é útil quando você não deseja alterar outros menus 
de configuração além dos presentes no menu Usuário.
Para desbloquear e voltar a exibir todas as listas dos menus, •	
mantenha pressionado o botão MENU e pressione a chave 
MENU ON/OFF ao mesmo tempo para exibir o menu de 
Configuração, então insira a mesma senha programada quando 
você bloqueou o menu.

Nota

Recomenda-se que você conserve sua senha para referência 
futura. Se você esquecer sua senha, entre em contato com um 
representante de serviço Sony.

Gravação Simultânea em 2 slots
A gravação simultânea usando 2 slots SxS é suportada.
As funções podem ser Ligadas/Desligadas em 
OPERAÇÃO>Função Grav.>Gravação simultânea.
Os seguintes formatos são suportados:

Os seguintes formatos no modo exFAT/HD •	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Os seguintes formatos no modo UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Notas
Quando usar a gravação simultânea, utilize cartões de memória •	
de mesmo tipo e tamanho.
A gravação simultânea não pode ser usada em conjunto com as •	
seguintes funções:

Gravação de Fotogramas–
Gravação Contínua de Clipes–
Gravação de Imagem em Cachê–
Câmera Lenta e Rápida–
Gravação com Intervalos–

O USB Wireless LAN Module IFU-WLM3 não pode ser usado •	
durante a gravação simultânea.

Suporta o cartão SDXC 
Utilizando-se um adaptador de mídia opcional MEAD-SD02, você 
pode gravar e reproduzir um cartão SDXC.
O cartão SDXC só pode ser usado no modo exFAT.
Cartão SDXC (Classe de velocidade SD: 10)

Notas
Quando você usar um cartão SDXC com essa unidade, •	
formate-o usando a função de formatação da unidade.
A reprodução em alta velocidade pode não ser executada •	
satisfatoriamente com um cartão SDXC.
Quando você usa um cartão SDXC, não utilize outros tipos de •	
cartões de memória simultaneamente. Se você usar outros 
tipos de mídia ao mesmo tempo, a mudança para outra mídia 
não poderá ser executada quando o espaço de armazenamento 
da mídia for esgotado durante a gravação.
A gravação no formato XAVC-I ou em Câmera Lenta e Rápida •	
poderá não ser executada corretamente dependendo do cartão 
SDXC utilizado. Recomenda-se o uso de um cartão de memória 
SxS.
Um cartão SDXC gravado com câmeras de vídeo das séries •	
PMW e PXW talvez não possa ser usado para gravação e 
reprodução com essa unidade, dependendo do tipo de 
unidade usada. Para maiores detalhes, entre em contato com 
seu revendedor Sony ou com um representante de serviço 
Sony.

Adicionando o menu atalho
Quando o menu atalho estiver habilitado, as configurações 
poderão ser alteradas nos itens exibidos na tela do visor sem 
exibir os menus com a chave MENU ON/OFF.
O menu atalho está habilitado quando o menu 
MANUTENÇÃO>Menu Atalho está definida como Lig.
Habilite os ajustes por meio do menu atalho e opere-os 
diretamente usando o botão MENU. Os seguintes itens podem 
ser operados.

Ajustes de COLOR TEMP do equilíbrio de branco•	
Ajustes de modo para TLCS•	
Velocidade de obturador para o obturador eletrônico ou ajuste •	
do número de fotogramas acumulados
Ajuste da taxa de fotograma no modo Câmera Lenta e Rápida•	

Notas
Quando os itens do menu atalho não forem exibidos na tela do •	
visor (menu OPERAÇÃO>Pain. Lig/Desl é ajustado para Desl.), 
você não poderá operar esses itens com o menu atalho.
Essas são as condições para habilitar o menu direto •	
dependendo dos itens.

COLOR TEMP configuração de balanço de branco –
Quando a chave WHITE BAL (alternar a memória de balanço 
de branco) é posicionada em “A” ou “B,” e quando a chave 
WHITE BAL é posicionada em “B” enquanto a 
OPERAÇÃO>Config. Branco>Alt. Br.<B>>Memória no menu
Configuração de velocidade de obturador para obturador –
eletrônico 
Todos os modos: 
A chave SHUTTER é definida para ON. 
Modo de velocidade: 
OPERAÇÃO>Obturad.>Seleç. Obturador>Segundo no menu  
Modo Ângulo: 
OPERAÇÃO>Obturad.>Seleç. Obturador>Degree no menu 
Modo ECS: 
O modo ECS é definido.
Configuração de número de quadros acumulados do –
obturador eletrônico 
Modo Obturador Lento: OPERAÇÃO>Obturad.>Obturador 
Lento>Lig. no menu
Configuração de taxa de quadros no modo Devagar & Rápido –
OPERAÇÃO>Função Grav.>Devagar & Rápido>Lig. no menu



   

Transferência parcial de um arquivo original gravado nesta 
unidade
Você pode transferir uma parte cortada de um arquivo 
especificando os pontos de Início e Fim no arquivo original 
gravado por esta unidade. 
Também é possível transferir as partes cortadas de vários arquivos 
usando o Storyboard.
O seguinte dispositivo e aplicativo são necessários para 
transferências parciais.

Prenda o adaptador sem fio CBK-WA101 (opcional) a esta •	
câmera de vídeo.
Use o aplicativo Content Browser Mobile no dispositivo que •	
estiver conectado por meio da Wireless LAN a esta câmera de 
vídeo. (Use a versão mais recente do aplicativo “Content 
Browser Mobile”.)

Os seguintes arquivos originais são suportados:
Os seguintes arquivos no modo exFAT/HD •	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Os seguintes arquivos no modo UDF/HD •	
MPEG2 HD422–
MPEG2 HD420HQ–

Notas
Para transferir o arquivo original parcialmente usando o •	
“Content Browser Mobile”, grave o arquivo proxy com o mesmo 
nome de arquivo do original com as configurações a seguir.

Menu MANUTENÇÃO>Config. Câmera>Controle Grav. –
SDI>Grav Sim.
Menu MANUTENÇÃO>Config. Câmera>Comb.nomb.clip>Lig.–

Ao transferir o arquivo original parcialmente, as seguintes •	
operações não podem ser realizadas.

Operação de clipe–
Formatação de mídia–
Conexão ao computador por USB–

Durante uma transferência parcial do arquivo original, o tempo •	
para armazenar imagens na memória do gravador em memória 
cachê leva menos tempo que o tempo definido no menu 
OPERAÇÃO>Função Grav.>Tempo Grav Imag.Cache

Adicionar a exibição do status dos ajustes do controle 
remoto Wi-Fi 
A exibição dos ajustes da Config. Wi-Fi>Wi-Fi Remoto sob o menu 
MANUTENÇÃO é adicionada á tela de status das chaves/remoto 
atribuíveis.

Menu Wi-Fi 
Ao se conectar por meio do adaptador sem fio CBK-WA101 
(opcional), você pode ajustar as Config. Wi-Fi>Wi-Fi e Config. 
Wi-Fi>Wi-Fi Remoto no menu MANUTENÇÃO.

Adicionando a tela de exibição 
Os seguintes status podem ser exibidos na tela do visor quando o 
adaptador sem fio CBK-WA101 (opcional) estiver conectado.

Exibe o status da conexão com fio LAN com o mostrador de •	
status do adaptador sem fio CBK-WA101 (opcional).
Exibe o status de conexão do modo do cliente de rede.•	
Exibe o status da transmissão contínua (streaming).•	

Principais funções atualizadas para a V1.5
Formatos de vídeo
PMW-400/580 é compatível com o formato de gravação de 
MPEG2 no modo exFAT.

SD agora pode ser selecionado em “HD/SD” em “Formatar” do •	
menu OPERAÇÃO no modo exFAT.

“29.97P”, “23.98P” e “25P” são adicionados à lista de itens •	
selecionáveis de “Freq. Sist.” em “Formatar” do menu OPERAÇÃO 
no modo exFAT/HD/720.
“HD422”, “HQ” e “DVCAM” são adicionados aos itens selecionáveis •	
de “Form. Grav” em “Formatar” do menu OPERAÇÃO no modo 
exFAT .

Principais funções atualizadas para a V1.4
Formatos de vídeo
PMW-400/580 é compatível com o formato de XAVC Long GOP 
(XAVC-L).

“XAVC-L 50”, “XAVC-L 35” e “XAVC-L 25” foram adicionados aos •	
itens de seleção de “Form. Grav” em “Formatar” do menu 
OPERAÇÃO no modo exFAT.

PMW-400/580 é compatível com a exibição de versão de CBK-
CE01.

“CBK-CE01” foi adicionado à “Versão” do menu MANUTENÇÃO.•	

Principais funções atualizadas para a V1.3
Formatos de vídeo
PMW-400/580 é compatível com o formato de XAVC intra-quadro 
(XAVC-I).

“exFAT” é adicionado para os itens selecionáveis do “Arq. Sistema” •	
no “Formatar” do menu de OPERAÇÃO. Quando “exFAT” é 
selecionado, “XAVC-I” é definido automaticamente.

Principais funções atualizadas para a V1.22
As funções foram agora melhoradas.

Quando adicionado ao HXCU-FB70, o botão HXCU-FB70 PRESET •	
(predefinição de balanço de branco) é ativado.
CA agora é exibido no menu MANUTENÇÃO menu ->Genlock> •	
Ref.
As melhorias foram realizadas para que o NDF não apareça na •	
tela de status do painel LCD monocromático quando o País 
estiver definido como PAL. 
As melhorias foram realizadas na exibição do formato de vídeo •	
na tela no visor ocular quando o Form. Grav no modo UDF fosse 
definido para HD420 HQ1920.

Principais funções atualizadas para a V1.2
Função de conexão de mídia por USB
É suportada a cópia e reprodução de clips em mídia de 
armazenamento externos com interface USB, como um disco 
rígido ou uma unidade flash, ligando através do conector 
OPTION.

O conjunto USB foi adicionado ao menu MANUTENÇÃO. Você •	
pode operar uma mídia USB usando esse item do menu.
Os clips armazenados em cartões de memória SxS podem •	
agora ser copiados e salvos em mídias de armazenamento 
externos.
Os clips salvos em mídias de armazenamento externos podem •	
agora ser copiados para cartões de memória SxS.
Os clips salvos em mídias de armazenamento externos podem •	
agora ser reproduzidos diretamente.

Notas
São suportados dispositivos de armazenamento externos que •	
operam com fonte de alimentação de 5,0 V/0,5 A. A unidade 
pode não reconhecer outros dispositivos de armazenamento. 
Nesse caso, forneça uma fonte de alimentação independente 
para o dispositivo de armazenamento.
Não é garantido o funcionamento de todas as mídias. Consulte •	
a loja onde adquiriu o gravador para saber quais as mídias 
suportadas pela unidade.



   

Antes de usar uma mídia USB, formate usando Formatar USB no •	
menu da câmera de vídeo.

Adaptador de câmera
Quando o adaptador de câmera está montado, não é possível 
usar os botões do painel interior.

O item do menu MANUTENÇÃO >Config. Câmera >Operação •	
CCU  permite configurar o funcionamento da unidade principal 
para Normal ou Local (ou seja, ativar ou desativar).

Notas
Se você alterar as configurações de funcionamento da unidade •	
principal, a unidade irá reiniciar automaticamente.
Quando o funcionamento da unidade principal está ativado, •	
estão ativas as funções de exibição para o controlador remoto 
do CCU e a exibição de vídeos de retorno e as funções de 
contagem e chamada do CCU, mas o controle remoto através 
do CCU ou do conector REMOTE está desativado.

Função de compensação da aberração
A função de compensação da aberração foi melhorada.

Principais funções atualizadas para a V1.1
Função Red. Faixa Flash
A PMW-400/580 é compatível com a função Red. Faixa Flash.

Você pode Lig./Deslig. a função “Red. Faixa Flash” no menu •	
OPERAÇÃO. 
A operação Lig./Deslig. da Red. Faixa Flash pode ser atribuída ao •	
botão atribuível em “Alt. Atribuív.” do menu OPERAÇÃO.
Você pode Lig/Deslig a indicação do status da Red. Faixa Flash •	
em “Red. Faixa Flash” no “Pain. Lig/Desl” do menu OPERAÇÃO.

Notas
O vídeo e o áudio podem ser distorcidos quando a função Red. •	
Faixa Flash está configurada para “Lig.” ou “Desl.”.
Quando o “Obturad.” estiver configurado para “Lig.”, enquanto a •	
função Red. Faixa Flash também estiver configurada. para “Lig.”, a 
função Red. Faixa Flash será configurada para “Desl.” 
automaticamente.
A função Red. Faixa Flash não poderá ser configurada para “Lig.” •	
quando a câmera estiver no modo de cache de imagem, modo 
de gravação S&Q, modo de obturador lento, ou estiver usando a 
saída i.LINK.
A função Red. Faixa Flash será “Desl.” quando a câmera for •	
reiniciada. Configure para a função “Lig.” novamente.

Menu Multi Language e mensagem (PMW-400 apenas)
Menus e mensagens estão disponíveis em espanhol, português, 
russo e indonésio. Mensagens em japonês também se 
encontram disponíveis.
“Japanese”, “Spanish”, “Portuguese”, “Russian”, e  “Indonesian” foram 
incluídos em “Language” no menú MANUTENÇÃO.
Nota

Os menus serão exibidos em inglês e as mensagens exibidas •	
em japonês ao selecionar “Japanese”.

Adaptador sem fio
A PMW-400/580 é compatível com o Adaptador Sem fio opcional 
CBK-WA101.

Você pode configurar “Controle Grav. SDI” em “Config. Câmera” •	
no menu MANUTENÇÃO para “Grav Sim.” para permitir a 
gravação sincronizada. 
Você pode Lig./Deslig. a função Combine o nome do clipe •	
durante uma gravação sincronizada em “Combine o nome do 
clipe” em “Config. Câmera” do menu MANUTENÇÃO.

Você pode Lig./Deslig. a indicação de status sem fio do •	
adaptador sem fio em “Status sem fio” em “Pain. Lig/Desl” no 
menu OPERAÇÃO.
Você pode Lig./Deslig. a indicação de tempo restante para um •	
cartão SD inserido no adaptador sem fio em “Restante da mídia 
suplementar” em “Pain. Lig/Desl” no menu OPERAÇÃO.
Você pode Lig/Deslig a indicação de status de upload do clipe •	
via adaptador sem fio em “Enviando info do clipe” em “Pain. Lig/
Desl” no menu OPERAÇÃO.

Notas
As Funções Wi-Fi do Adaptador Wi-Fi CBK-WA01 ou do Módulo •	
LAN wireless USB IFU-WLM3 não estarão disponíveis quando o 
adaptador sem fio estiver conectado.
“Grav Sim.” não poderá ser configurada nos modos de gravação •	
especiais. Você pode usar os seguintes formatos de vídeo para 
“Grav Sim.”. 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

Módulo USB wireless LAN
A PMW-400/580 é compatível com o Módulo USB wireless LAN 
opcional IFU-WLM3, que permite a conexão Wi-Fi.
Notas

Para a configuração de “Pesquisar Redes” em “Config. Wi-Fi” no •	
menu MANUTENÇÃO, apenas “SSID” e “Ch” vão aparecer na lista 
NETWORK SCAN. Configure “Tipo de Rede” em “Config. Wi-Fi” no 
menu MANUTENÇÃO novamente depois de selecionar a 
conexão.
Quando “Tipo de Rede” está configurado como “Adhoc”, “Status •	
Wi-Fi” em “Config. Wi-Fi” no menu MANUTENÇÃO vai ficar 
esmaecida, e o status da conexão não será exibido.

Formatos de vídeo
A PMW-400/580 é compatível com o formato de gravação de 
UDF (MXF) HD420 35Mbps 1920×1080.

“HD420 HQ1920” é adicionado aos itens selecionáveis de “Form. •	
Grav” em “Formatar” do menu OPERAÇÃO no modo UDF/
HD/1080.

Função ALAC (correção de aberração)
A PMW-400/580 é compatível com a função ALAC, podendo 
desligá-la. Além disso, o status é apresentado na forma 
correspondente.

Você pode Lig./Deslig. a função ALAC em “ALAC” em “Config. •	
Câmera” no menu MANUTENÇÃO. A função ALAC pode ser 
operada remotamente pelo conector REMOTE.
Você pode Lig./Deslig. a indicação de status do ALAC em “ALAC” •	
em “Pain. Lig/Desl” do menu OPERAÇÃO. “ALAC” vai aparecer na 
tela do visor quando a indicação de status de ALAC e a função 
ALAC estiverem configuradas como “Lig.” e “Auto” 
respectivamente a aberração será corrigida pela lente 
compatível ALAC.

Nota
“ALAC” não será exibida sem a correção de aberração, mesmo •	
quando uma lente compatível ALAC estiver ligada à 
videocâmera. Neste caso, calibre a lente na forma 
correspondente.



   

Bahasa Indonesia

Catatan Rilis
Fungsi utama yang diperbarui dengan V1.7
Menambahkan Layar Status RECENT FILES
Layar status menampilkan informasi berkas (hingga 15 berkas) 
yang baru saja dimuat dalam daftar sesuai dengan urutan 
pemuatan berkas.
Di layar status RECENT FILES, Anda dapat menampilkan sampai 
15 berkas informasi dalam daftar (masing-masing sampai 3 
berkas untuk berkas Pengguna, berkas Semua, berkas Adegan, 
berkas Ref., atau berkas Lensa).
Tanggal dan waktu berkas dimuat, jenis berkas, jenis media, dan 
nama berkas ditampilkan.

Mendaftarkan menu kustomisasi berkas ke menu 
PENGGUNA
Item berikut dalam menu BERKAS dapat didaftarkan ke menu 
PENGGUNA.

BERKAS > Pengguna•	
  > Pengguna Memuat SxS
  > Pengguna Menyimpan SxS
  > Pengguna Memuat USB
  > Pengguna Menyimpan USB
  > ID Berkas 
  > Panggil Preset Pengguna

BERKAS > Semua •	
  > Semua Muat SxS
  > Semua Simpan SxS
  > Semua Muat USB
  > Semua Simpan USB
  > Semua Preset 

BERKAS > Adegan•	
  > Panggil Adegan SxS
  > Simpan Adegan SxS
  > Panggil Adegan USB
  > Simpan Adegan USB

Menonaktifkan pengaturan tetapan saat menu dikunci
Jika item menu yang tidak terdaftar di menu PENGGUNA 
ditetapkan ke "SW Tetapan" saat menu dikunci, pengaturan 
tetapan akan dinonaktifkan.
Fungsi ini berguna jika Anda tidak ingin mengubah pengaturan 
menu selain menu PENGGUNA.
Catatan

Jika menu dikunci saat item menu pada menu konfigurasi yang 
tercantum di bawah ini tidak didaftarkan ke menu PENGGUNA, 
fungsi item menu tidak dapat ditetapkan ke "SW Tetapan".

Item menu pada menu 
konfigurasi

Item menu yang dapat 
ditetapkan ke "SW 
Tetapan"

OPERASI > Fungsi Rek. > Rek. 
Chache Gbr. Cache Gbr.

OPERASI > Fungsi Rek. > Rek. 
Klip Terusan Rek. Klip Terusan

OPERASI > Pngaturan VF > 
Modus Modus EVF

OPERASI > Layar On/Off > 
Layar Kecerahan Layar BRT

OPERASI > Layar On/Off > 
Layar Histogram Histogram

OPERASI > Layar On/Off > 
Info Lensa Info Lensa

OPERASI > TLCS > Modus 
Chaya Sort

Lampu Latar

OPERASI > TLCS > AGC*

Modus EZOPERASI > TLCS > Rana 
Otomat*

OPERASI > Penanda > Atur Penanda

PEMELIHARAAN > Audio > 
Pilih MIC Dpn Mic Depan

Meskipun "AGC" atau "Rana Otomat" tidak didaftarkan ke menu * 
PENGGUNA, "Modus EZ" tidak dapat dipilih dengan "SW 
Tetapan".

Waktu perekaman media SxS ditingkatkan
Waktu perekaman maksimal untuk merekam beberapa klip pada 
media SxS ditingkatkan.

Fungsi utama yang diperbarui dengan V1.6
Format video
Perekaman IMX didukung dalam modus exFAT.

IMX50 ditambahkan ke item pengaturan menu untuk •	
OPERASI>Format>Format Rek dalam modus exFAT/SD.

Menambahkan menu Pengguna
Menu Pengguna baru saja ditambahkan dan Anda dapat 
mendaftarkan item yang sering digunakan dalam menu OPERASI, 
MENGECAT, atau menu PEMELIHARAAN ke menu Pengguna. 
Registrasi dapat dilakukan di menu KUSTOM. MENU PENGGUNA.

Menambahkan fungsi menu penguncian
Fungsi untuk mengunci menu Konfigurasi dan untuk 
menampilkan menu Pengguna ditambahkan.

Terus tekan kenop MENU dan tekan sakelar MENU ON/OFF •	
secara bersamaan untuk menampilkan menu Konfigurasi dan 
memasukkan kata sandi di User Menu with Lock>On untuk 
mengunci tampilan menu dan hanya menampilkan menu 
Pengguna. 
Fungsi ini berguna ketika Anda tidak ingin mengubah 
pengaturan menu selain yang terdapat dalam menu Pengguna.
Untuk melepas kunci dan menampilkan kembali seluruh daftar •	
menu, terus tekan kenop MENU dan tekan sakelar MENU ON/
OFF secara bersamaan untuk menampilkan menu Konfigurasi, 
lalu memasukkan kata sandi yang sudah dimasukkan ketika 
Anda mengunci menu.

Catatan

Sebaiknya simpan kata sandi untuk referensi di waktu 
mendatang. Jika Anda lupa dengan kata sandi, hubungi 
perwakilan servis Sony.

Perekaman Simultan dalam 2 slot
Perekaman simultan menggunakan slot 2 SxS didukung.



   

Fungsi dapat diaktifkan atau dinonaktifkan dari OPERASI>Fungsi 
Rek.>Rekam Simultan.
Format berikut ini didukung:

Format berikut ini dalam modus exFAT/HD•	
XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

Format berikut ini dalam modus UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Catatan
Ketika menggunakan Perekaman Simultan, gunakan kartu •	
memori dengan tipe dan ukuran yang sama.
Perekaman Simultan tidak dapat digunakan dengan fungsi •	
berikut ini secara bersamaan:

Perekaman Frame–
Perekaman Klip Terus Menerus–
Perekaman Cache Gambar–
Gerakan Lambat & Cepat–
Perekaman Interval–

USB Wireless LAN Module IFU-WLM3 tidak dapat digunakan •	
selama rekaman simultan.

Mendukung kartu SDXC
Dengan menggunakan Adaptor Media MEAD-SD02 opsional, 
Anda dapat merekam dan memutar kartu SDXC.
Kartu SDXC hanya dapat digunakan ketika dalam modus exFAT.
Kartu SDXC (SD Kelas Kecepatan: 10)
Catatan

Ketika menggunakan kartu SDXC dengan unit ini, format kartu •	
tersebut menggunakan fungsi pemformatan unit.
Pemutaran berkecepatan tinggi tidak dapat dicapai dengan •	
baik dengan kartu SDXC.
Ketika menggunakan kartu SDXC, jangan menggunakan jenis •	
kartu memori lain secara bersamaan. Jika Anda menggunakan 
jenis media lain secara bersamaan, Anda tidak dapat beralih ke 
media lain ketika media tersebut tidak memiliki ruang selama 
perekaman.
Perekaman dengan format XAVC-I atau perekaman Gerakan •	
Lambat & Cepat tidak dapat dilakukan dengan benar, 
bergantung pada kartu SDXC yang digunakan. Kartu memori 
SxS direkomendasikan.
Kartu SDXC yang digunakan untuk melakukan perekaman •	
dengan camcorder seri PMW dan PXW mungkin tidak dapat 
digunakan untuk melakukan perekaman dan pemutaran 
dengan unit ini, bergantung pada tipe unit yang digunakan. 
Untuk informasi mendetailnya, hubungi dealer Sony Anda atau 
perwakilan layanan Sony.

Menambahkan menu langsung
Jika menu langsung diaktifkan, pengaturan dapat diubah dari 
item tampilan di layar jendela bidik tanpa menampilkan menu 
dengan sakelar MENU ON/OFF.
Menu langsung diaktifkan ketika menu PEMELIHARAAN>Menu 
Lngsung diatur ke On.
Aktifkan pengaturan menu langsung dan operasikan secara 
langsung dengan menggunakan kenop MENU. Item berikut ini 
dapat dioperasikan.

Pengaturan COLOR TEMP dari keseimbangan putih•	
Pengaturan modus untuk TLCS•	
Kecepatan rana dari rana elektronik atau pengaturan untuk •	
jumlah akumulasi bingkai
Pengaturan bingkai dalam modus Gerakan Lambat & Cepat•	

Catatan
Jika item untuk menu langsung tidak ditampilkan di layar •	
jendela bidik (menu OPERASI>Layar On/Off diatur ke Off ), Anda 
tidak dapat mengoperasikan item tersebut dengan menu 
langsung.
Berikut ini adalah ketentuan untuk mengaktifkan menu •	
langsung yang tergantung pada item.

Pengaturan COLOR TEMP keseimbangan putih –
Ketika sakelar WHITE BAL (mengubah memori keseimbangan 
putih) diposisikan di "A" atau "B," dan ketika sakelar WHITE BAL 
diposisikan di "B" saat OPERASI>Pngturn Ptih>Alihan 
Putih<B>>Memori di menu
Pengaturan kecepatan rana dari rana elektronik –
Semua mode: 
Sakelar SHUTTER diatur ke ON. 
Mode kecepatan: 
OPERASI>Rana>Pilih Rana>Detik di menu 
Mode sudut: 
OPERASI>Rana>Pilih Rana>Derajat di menu 
Mode ECS: 
Mode ECS ditetapkan.
Pengaturan nomor bingkai rana elektronik yang terakumulasi –
Mode Rana Lambat: OPERASI>Rana>Rana Lambat>On di 
menu
Pengaturan laju bingkai dalam mode Gerak Lambat & Cepat –
OPERASI>Fungsi Rek.>Lambat & Cepat>On di menu

Transfer sebagian dari file asli yang direkam pada unit ini
Anda dapat mentransfer bagian potongan sebuah file dengan 
menentukan titik In dan Out pada file asli yang direkam dengan 
unit ini. 
Anda juga dapat mentransfer bagian potongan dari beberapa file 
menggunakan Storyboard.
Perangkat dan aplikasi berikut ini memerlukan transfer parsial.

Pasang adaptor nirkabel CBK-WA101 (opsional) ke camcorder •	
ini.
Gunakan aplikasi Content Browser Mobile pada perangkat yang •	
terhubung melalui Wireless LAN dengan camcorder ini. 
(Gunakan versi terbaru dari aplikasi "Content Browser Mobile".)

File asli berikut ini didukung:
File berikut ini dalam modus exFAT/HD•	

XAVC-I–
XAVC-L50, L35, L25–
MPEG2 HD422–
MPEG2 HD420HQ–

File berikut ini dalam modus UDF/HD•	
MPEG2 HD422–
MPEG2 HD420HQ–

Catatan
Untuk mentransfer berkas asli secara parsial dengan "Content •	
Browser Mobile," rekam berkas proxy dengan nama berkas yang 
sama seperti berkas asli dengan pengaturan berikut.

Menu PEMELIHARAAN>Konfig. Kamera>Kontrol Rek. SDI>Rek –
Paralel
Menu PEMELIHARAAN>Konfig. Kamera>Nama Klip Sesuai>On–

Ketika mentransfer file asli secara parsial, operasi berikut tidak •	
dapat dilakukan.

Pengoperasian klip–
Media pemformatan–
Menghubungkan ke PC via USB–

Ketika mentransfer file asli secara parsial, waktu untuk •	
menyimpan gambar dalam memori cache gambar dari 
rekaman cache gambar kurang dari waktu yang ditetapkan 
dalam menu OPERASI>Fungsi Rek.>Waktu Rek. Cache Gbr



   

Menambahkan tampilan status pengaturan kontrol jarak 
jauh Wi-Fi
Tampilan pengaturan Pngaturn Wi-Fi>Remote Wi-Fi dalam menu 
PEMELIHARAAN ditambahkan ke switch assignable/layar status 
jarak jauh.

Menu Wi-Fi
Ketika tersambung melalui adaptor nirkabel CBK-WA101 
(opsional), Anda dapat mengatur Pngaturn Wi-Fi>Wi-Fi dan 
Pngaturn Wi-Fi>Remote Wi-Fi dalam menu PEMELIHARAAN.

Menambahkan tampilan layar
Status berikut ini dapat ditampilkan di layar jendela bidik ketika 
adaptor nirkabel CBK-WA101 (opsional) terhubung.

Menampilkan status sambungan LAN berkabel ke tampilan •	
status adaptor nirkabel CBK-WA101 (opsional).
Menampilkan status sambungan modus klien jaringan.•	
Menampilkan status streaming.•	

Fungsi utama yang diperbarui dengan V1.5
Format Video
PMW-400/580 kompatibel dengan format rekaman MPEG2 dalam 
Modus exFAT.

SD sekarang dapat dipilih di "HD/SD" di "Format" pada menu •	
OPERASI dalam Modus exFAT.
"29.97P", "23.98P" dan "25P" ditambahkan ke item "Frek. Sistem" •	
yang dapat dipilih di "Format" pada menu OPERASI dalam 
Modus exFAT/HD/720.
"HD422", "HQ" dan "DVCAM" ditambahkan ke item "Format Rek" •	
yang dapat dipilih di "Format" pada menu OPERASI dalam 
Modus exFAT.

Fungsi utama yang diperbarui dengan V1.4
Format Video
PMW-400/580 kompatibel dengan format XAVC Long GOP 
(XAVC-L).

"XAVC-L 50", "XAVC-L 35" dan "XAVC-L 25" ditambahkan ke item •	
yang dapat dipilih dari "Format Rek" di "Format" dari menu 
OPERASI dalam Modus exFAT.

PMW-400/580 kompatibel dengan tampilan versi CBK-CE01.
"CBK-CE01" ditambahkan untuk "Versi" dari menu •	
PEMELIHARAAN.

Fungsi utama yang diperbarui dengan V1.3
Format Video
PMW-400/580 kompatibel dengan format intra-frame XAVC  
(XAVC-I).

"exFAT" ditambahkan untuk item yang dipilih dari "Sistem •	
Berkas" dalam "Format" menu OPERASI. Apabila "exFAT" dipilih, 
"XAVC-I" diatur secara otomatis.

Fungsi utama yang diperbarui dengan V1.22
Fungsi sekarang ditingkatkan.

Saat digabungkan dengan HXCU-FB70, tombol HXCU-FB70 •	
PRESET (preset keseimbangan putih) diaktifkan.
CA sekarang ditampilkan di menu PEMELIHARAAN ->Genlock> •	
Referensi.
Peningkatan dilakukan sehingga NDF tidak muncul di tampilan •	
status panel LCD monokrom jika Negara diatur ke PAL.
Peningkatan dilakukan terhadap tampilan format video di layar •	
jendela bidik jika HD420 HQ1920 diatur untuk Format Rek 
dalam mode UDF.

Fungsi utama yang diperbarui dengan V1.2
Fungsi Koneksi Media USB
Penyalinan dan pemutaran didukung untuk klip pada media 
penyimpanan eksternal yang memiliki antarmuka USB, seperti 
hard disk atau flash drive, dengan koneksi ke konektor OPTION.

Set USB sudah ditambahkan ke menu PEMELIHARAAN. Anda •	
dapat mengoperasikan media USB dengan item menu ini.
Klip yang disimpan di kartu memori SxS sekarang dapat disalin •	
dan dibuat cadangannya pada media penyimpanan eksternal.
Klip di media penyimpanan eksternal sekarang dapat disalin ke •	
kartu memori SxS.
Klip di media penyimpanan eksternal sekarang dapat diputar •	
secara langsung.

Catatan
Perangkat penyimpanan eksternal yang dioperasikan dari •	
sumber daya 5,0 V/0,5 A didukung. Unit mungkin tidak 
mengenali perangkat penyimpanan lain. Dalam kasus tersebut, 
sediakan sumber daya terpisah untuk perangkat penyimpanan 
tersebut.
Pengoperasian tidak dijamin berhasil untuk semua media. •	
Konsultasikan dengan toko tempat Anda membeli perekam 
tentang media yang diverifikasi untuk digunakan di unit ini.
Sebelum menggunakan media USB, formatlah dengan Format •	
USB di menu camcorder.

Adaptor kamera
Pengoperasian sakelar untuk panel internal saat adaptor kamera 
dipasang sekarang didukung.

Item menu PEMELIHARAAN >Konfig. Kamera >Operasi CCU •	
memungkinkan Anda menetapkan pengoperasian sakelar unit 
utama ke Norm atau Lokal (yaitu, dinonaktifkan atau diaktifkan).

Catatan
Jika Anda mengubah pengaturan pengoperasian sakelar unit •	
utama, unit akan dimulai ulang secara otomatis.
Jika pengoperasian sakelar unit utama diaktifkan, tampilan ke •	
pengendali jarak jauh CCU dan tampilan video balik dan 
pengoperasian hitungan dan panggilan dari CCU diaktifkan, 
tetapi remote control melalui CCU atau melalui konektor 
REMOTE dinonaktifkan.

Fungsi kompensasi aberasi
Fungsi kompensasi aberasi ditingkatkan.

Fungsi utama yang diperbarui dengan V1.1
Fungsi Pengurangan Pita Lampu Kilat
PMW-400/580 kompatibel dengan fungsi pengurangan pita 
lampu kilat.

Anda dapat Mengaktifkan/Menonaktifkan fungsi pengurangan •	
pita lampu kilat di Pngurang Pita Lmpu Klat dari menu OPERASI.
Operasi Mengaktifkan/Menonaktifkan pengurangan pita lampu •	
kilat dapat ditetapkan ke tombol tetapan di SW Tetapan pada 
menu OPERASI.
Anda dapat Mengaktifkan/Menonaktifkan indikasi status •	
pengurangan pita lampu kilat dari Pngurang Pita Lmpu Klat di 
Layar On/Off pada menu OPERASI.

Catatan
Video dan audio mungkin terdistorsi jika fungsi pengurangan •	
pita lampu kilat diatur ke On atau Off.
Jika Rana diatur ke On sementara fungsi pengurangan pita •	
lampu kilat diatur ke On, fungsi pengurangan pita lampu kilat 
ke Off secara otomatis.
Fungsi pengurangan pita lampu kilat tidak dapat diatur ke On •	
jika camcorder berada dalam modus cache gambar, modus 
perekaman S&Q, modus rana lambat, atau mengeluarkan i.LINK.



   

Fungsi pengurangan pita lampu kilat dimatikan atau Off jika •	
camcorder dinyalakan ulang. Atur fungsi ke On lagi.

Menu dan Pesan Multi Bahasa (PMW-400 saja)
Tersedia menu dan pesan dalam Bahasa Spanyol, Portugal, Rusia, 
dan Indonesia. Selain itu, pesan dalam bahasa Jepang juga 
tersedia.
Japanese, Spanish, Portuguese, Russian, dan Indonesian 
ditambahkan di Language pada menu PEMELIHARAAN.
Catatan

Menu ditampilkan dalam bahasa Inggris dan pesan ditampilkan •	
dalam bahasa Jepang saat memilih Japanese.

Adaptor Nirkabel
PMW-400/580 kompatibel dengan Adaptor Nirkabel CBK-WA101 
opsional.

Anda dapat mengatur Kontrol Rek. SDI di Konfig. Kamera pada •	
menu PEMELIHARAAN ke Rek Paralel untuk memungkinkan 
perekaman tersinkronkan.
Anda dapat Mengaktifkan/Menonaktifkan fungsi penyesuaian •	
nama klip saat perekaman tersinkronkan di Nama Klip Sesuai di 
Konfig. Kamera pada menu PEMELIHARAAN.
Anda dapat Mengaktifkan/Menonaktifkan indikasi status untuk •	
adaptor nirkabel di Status Nirkabel di Layar On/Off pada menu 
OPERASI.
Anda dapat Mengaktifkan/Menonaktifkan indikasi sisa waktu •	
untuk kartu SD yang dimasukkan ke adaptor nirkabel di Sisa 
Media Eks di Layar On/Off pada menu OPERASI.
Anda dapat Mengaktifkan/Menonaktifkan indikasi status •	
pengunggahan klip melalui adaptor nirkabel di Mengirim Info 
Klip di Layar On/Off dari menu OPERASI.

Catatan
Fungsi Wi-Fi dari Adaptor Wi-Fi CBK-WA01 atau modul LAN •	
nirkabel USB IFU-WLM3 tidak tersedia saat adaptor nirkabel 
tersambung.
Rek Paralel tidak dapat diatur dalam modus perekaman khusus. •	
Anda dapat menggunakan format video berikut ini untuk Rek 
Paralel. 
1920×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1440×1080/59.94i, 50i, 29.97P, 25P, 23.98P 
1280×720/59.94P, 50P

Modul LAN nirkabel USB
PMW-400/580 kompatibel dengan modul LAN nirkabel USB 
IFU-WLM3 opsional yang memungkinkan sambungan Wi-Fi.
Catatan

Untuk pengaturan Pindai Jaringan di Pngaturn Wi-Fi pada menu •	
PEMELIHARAAN, hanya SSID dan Ch muncul di daftar NETWORK 
SCAN. Atur Tipe Jaringan di Pngaturn Wi-Fi dari menu 
PEMELIHARAAN lagi setelah memilih sambungan.
Jika Tipe Jaringan diatur ke Adhoc, Status Wi-Fi di Pngaturn Wi-Fi •	
pada menu PEMELIHARAAN berwarna abu-abu, dan status 
sambungan tidak ditampilkan.

Format Video
PMW-400/580 kompatibel dengan format perekaman UDF (MXF) 
HD420 35Mbps 1920×1080.

HD420 HQ1920 ditampilkan untuk item yang bisa dipilih dari •	
Format Rek di Format pada menu OPERASI dalam Modus UDF/
HD/1080.

Fungsi ALAC (Koreksi Aberasi)
PMW-400/580 kompatibel dengan fungsi ALAC dan dapat 
mematikan fungsi ini. Selain itu, statusnya ditampilkan sesuai 
kondisi.

Anda dapat Mengaktifkan/Menonaktifkan fungsi ALAC dari •	
ALAC di Konfig. Kamera pada menu PEMELIHARAAN. Fungsi 
ALAC dapat dioperasikan dari jarak jauh melalui konektor 
REMOTE.
Anda dapat Mengaktifkan/Menonaktifkan petunjuk status ALAC •	
dari ALAC di Layar On/Off pada menu OPERASI. ALAC 
ditampilkan di layar jendela bidik ketika petunjuk status ALAC 
dan fungsi ALAC berturut-turut diatur ke On dan Otomat dan 
aberasi dikoreksi oleh lensa yang kompatibel dengan ALAC.

Catatan
ALAC tidak ditampilkan tanpa koreksi aberasi meskipun lensa •	
yang kompatibel dengan ALAC dipasang di camcorder. Dalam 
kondisi ini, kalibrasi lensa sesuai petunjuk.

MPEG-4 AVC Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL USE OF A CONSUMER OR OTHER 
USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO

(i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”)?AND/OR
(ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED 
FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER 
USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG 
LA, L.L.C. SEE
HTTP://WWW.MPEGLA.COM




